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4.2 System Monitoring 
This section describes the system monitoring tools used by DAAC operators: 

 
1. Big Brother – Better Than Free Edition 
2. Hyperic System Monitoring Tool 
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4.2.1 Big Brother - Better Than Free Edition 

Big Brother - Better Than Free Edition (BTF) or Big Brother is a network monitoring and 
notification COTS application. DAAC network administrators use it to monitor network devices 
and the services on those devices and to get feedback on their network's performance. Big 
Brother BTF provides the following capabilities: 

 Display - Big Brother displays status information as web pages or WML pages for 
WAP�enabled devices. These web pages have the systems monitored along the left hand 
side of the page, the tests for each system across the top of the page. This results in a 
matrix of color coded dots on screen. Green is normal, red indicates an alarm condition. 
In addition, the background color of the status pages is always the color of the most 
serious condition of any element being monitored at that time. 

 Architecture - Big Brother uses a client-server architecture combined with methods 
which both push and pull data. Network testing is done by polling all monitored services 
from a single machine, and reporting these results to a central location (the 
BBDISPLAY). If you want local system information, you can install a BB client on the 
local machine, which will send CPU, process, disk space, and logfile status reports in 
periodically. Each report is time stamped with an expiration date (like milk). This lets us 
know when a report is no longer valid, which is usually an indication of a more serious 
problem. 

 Protocol - Big Brother sends all status reports from client to server over port 1984. What 
other port would Big Brother use? The IANA has assigned Big Brother this port, and the 
BB protocol itself is open. Limited support for SNMP trap handling is supported using 
third-party plugins. 

 Platforms- The Big Brother servers and BBNET functions run on Unix/Linux, with a 
scaled-down version for NT/Win2K is also available. Client software is available for 
Unix/Linux, NT/Win2K/Win2003 while user contributed clients for Netware, Mac OS 9, 
VMS, AS/400 and VM/ESA at http://www.deadcat.net. 

 Network tests - Big Brother includes support for testing ftp, http, https, smtp, pop3, dns, 
telnet, imap, nntp, and ssh servers. Support for additional tests is easily added. 

 Local Tests - If you choose to install a BB client on a local machine, it will monitor disk 
space, CPU usage, messages, and can check that important processes are up and running. 

 Notification - Big Brother has a sophisticated notification. You can notify based on 
time-of-day, machine, or the test that failed. In addition there is support for an initial 
delay before paging (useful to cut down on late night false alarms), page-only-every 
defined amount of time, paging groups, acknowledgement, and escalation. Built in 
support for e-mail paging, alphanumeric paging via Qpage or Sendpage, or numeric and 
SMS pages. 

 History & Reporting - Big Brother supports reporting, which will allow you to determine 
whether Service Level Agreements are being met. In addition, Big Brother provides 
access to historical status information so you can see what the problem was at any given 
time. 
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 Plug-ins & Extensions - Big Brother supports plug-ins that can be written in any 
language. In addition, there is a worldwide support community that has contributed 
hundreds of plug-ins to monitor everything from Oracle Databases to CPU temperature 
on Solaris machines (http://www.deadcat.net). 

 Flexibility - Big Brother is very flexible. Warning and alarm levels are all easily 
redefinable. The Web Display can be easily customized. We have hooks into other 
products, like MRTG for bandwidth monitoring. Since you have the source code, you can 
easily figure out what Big Brother is doing, and change it to suit your needs. 

 Community - One of the best things about Big Brother is the community that has sprung 
up around it. Over 2000 Brothers on the various mailing list provide quick and friendly 
support and commentary. 

The EMD Big Brother BTF Release Notes (914-TDA-232) provides one way of configuring Big 
Brother.  Details of the configuration described in the release notes and other ways are provided 
in the documentation shipped in the Release Notes and media of Big Brother.  The common Big 
Brother functions used by the DAAC network administrators are listed in Table 4.2.1-1. 

Table 4.2.1-1.  Common ECS Operator Functions Performed with Big Brother 
Operating 
Function 

GUI Description When and why to Use 

View network 
devices/services 
status 
  

View icon color and 
on web GUI; view 
quick status dialog 
box. 
  

Icon color indicate the 
status of network devices 
and services. 
  

To verify that all network 
devices and services on 
the devices are 
operational. To ascertain 
network devices and 
services that are not 
operating properly. 

View network 
devices/services 
performance 
data 

Logs and Report 
menus on GUI 

A set of reports that can 
be viewed, printed, and/or 
its content transmitted to a 
file. 

To obtain status 
information about 
monitored devices and 
services. 

4.2.1.1 Quick Start using Big Brother 

Big Brother is a Web-based COTS application used to monitor network devices and services on 
the EMD Production LANs.  Big Brother capabilities are visible through the use of Big Brother 
GUIs.  

4.2.1.1.1 Invoking Big Brother 

To view the Big Brother display GUI, the operator connects to the Big Brother server's URL in 
an HTML browser such as Firefox or Internet Explorer.  The URL will be the hostname of the 
management server of the local site.  For instance, at the DAACs, the URL would be 
http://x4msl10.xxxx.ecs.nasa.gov/bb.   
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4.2.1.2 Big Brother Main Screen 

The main screen shown in Figure 4.2.1-1 shows an example of the main Big Brother page.  The 
main page is a matrix of host and monitored services. 

 

Figure 4.2.1-1.  Big Brother Main Page 

4.2.1.2.1 Menu Toolbar 

The Big Brother Server Display web page has a "Toolbar" at the upper left portion of the main 
page and sub-pages.  This toolbar (Figure 4.2.1-2) has four icons which are explained below in 
detail.  

 

Figure 4.2.1-2.  Big Brother Toolbar 
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  Notification/Page Acknowledgement – Clicking on this icon navigates to a page where 
administrators enter acknowledgment of events to pause notification alerts. 

  Condensed View – Clicking on this icon toggles the main page view from "full" list of 
hosts and services to a "condensed" view of hosts and services.  The condensed view displays 
only hosts and services that are displaying warnings or error conditions.  

  Availability Report – Clicking on this icon provides access to the availability reports, 
where an operator or administrator can investigate availability for a customized time-frame. 

  Help – Clicking on this icon will display a menu of help topics. 

4.2.1.2.2 Indications of a Device or Service Problem 

Big Brother automatically provides notification of host and service problems on any given host 
listed in bb-host. A host's service icons will remain green if the host and its services are 
responding to the Big Brother polls and the service is not impaired.  If a host is down, or its 
service(s) are impaired beyond the preset thresholds, the color of this host's service changes from 
green (OK) to yellow (Attention) to a red (Critical Problem) animated starburst shape as shown 
earlier in Figure 4.2.1-1.  Table 4.2.1-2 explains the color codes an operator can further drill 
down to find details of the condition that caused the impairment or outage, specifically in the 
case of a service impairment where a level such as CPU, or disk space crossed a predefined 
threshold.  Figure 4.2.1-3 shows the Error Detail Page. 

Table 4.2.1-2.  Color Codes by Order of Severity 

Code Description

 Red – Critical Problem 

 
  

Purple - No report - No report from this client in the last 30 minutes. The client 
may have died. 

 Yellow - Attention - The reporting system has crossed a threshold you should 
know about. 

 Green - OK – Status of host or service is normal. 

 Clear - Unavailable -The associated test has been turned off, or does not apply. A 
common example is connectivity on disconnected dialup lines. 

 Blue - Disabled - Notification for this test has been disabled. Used when 
performing maintenance. 

 
Acked - A current event has been acknowledged by one or many recipients. The 
acknowledgement is valid until the longest delay has expired 
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Figure 4.2.1-3.  Big Brother Error Detail Page 

4.2.1.2.3 Big Brother Reports 

Big Brother logs changes in the network host' status and its monitored services.  From the logged 
data, Big Brother can create availability reports as shown in Figures 4.2.1-4 and 4.2.1-5 

 

Figure 4.2.1-4.  Big Brother Availability Report Definition 
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Figure 4.2.1-5.  Big Brother Availability Report 

The Reports menu, in Big Brother Toolbar, Figure 4.2.1-2., provides access to the different types 
of reports and the variations of the reports. Refer to the Reports chapter of the Big Brother User's 
Guide for explanations of these reports and the instructions for creating and adding new reports 
to the Big Brother reports menus. 

4.2.1.3 Required Operating Environment 

The required operating environment is provided in the Big Brother BTF Release Notes posted on 
the EMD Baseline Information System's web pages at your local site. 

4.2.1.3.1 Interface and Data Type 

For host ping (determination whether ae host is active on the network), Big Brother uses ICMP 
(Internet Control Message Protocol) ping.  For other service status collection from Big Brother 
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client agents, service availability data is sent to the server via port 1984.  In addition, Big Brother 
server can be configured to retrieve information from each client's SNMP agent via standard 
SNMP protocol ports: 161/udp for general purpose (request/response) communications, and 
162/udp for trap. 

4.2.1.3.2 Databases 

Big Brother captures its event data in log files.  . 

4.2.1.3.3 Special Constraints 

None 

4.2.1.3.4 Outputs 

Outputs from Big Brother come in the form of Availability Report, Group Reports, and Device 
Reports.  These items can be displayed on the monitor and/or sent to the printer.  

4.2.1.3.5 Event and Error Messages 

Big Brother logs network and service event information in event logs. It changes the appearance 
of host's' icons on the main page to alert the operators and administrators something is not 
working properly. Big Brother sends out other types of notifications to designated persons if it is 
configured to do so. Refer to the Reports chapter of the Big Brother User's Guide for detailed 
information about Big Brother event and message activities. 

4.2.1.3.6 Reports 

Big Brother produces three types of reports: Availability Reports, Group Reports, and Device 
Reports. 
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4.2.2 Hyperic System Monitoring Tool 

4.2.2.1 Hyperic Overview 

Hyperic is a computer system and network monitoring application software. The software 
provides the ability to discover, organize, and monitor resources. The operator has the ability to 
control software resources remotely and control actions allow operator to execute tasks (e.g., 
starting and stopping resources. Alerts can be set on metrics and a control action can be 
configured to execute when an alert fires. Hyperic can respond to alerts in various ways such as 
email and sms. Hyperic's rich web-based interface allows the operator to view, manage, and 
configure resources. 

Figure 4.2.2.1-1 shows the key components of Hyperic and how they fit together. The 
information presented in this section can be found at http://www.hyperic.com. 

 

Figure 4.2.2.1-1.  Hyperic Architecture 

Note: Prior to Hyperic version 5.0, vFabric Hyperic was originally know as  Hyperic HQ. 

4.2.2.1.1 Hyperic Agent 

Hosts being monitored with Hyperic must have the Hyperic Agent installed and running. The 
agent will auto-discover software running on the host on startup and will periodically re-scan for 
configuration changes. The agent gathers metrics, performs log tracking, and event tracking. The 
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operator has the ability to perform control actions to start and stop servers. The Hyperic agent 
will send all gathered information to the Hyperic Server. (Figure 4.2.2.1-1) 

4.2.2.1.2 Hyperic Server and Hyperic Database 

Information gathered by the Hyperic Agent is sent to the Hyperic Server and is stored in the 
Hyperic Database. The server manages the software inventory and group of resources in useful 
ways to ease monitoring and management. The server handles alerts and executes configured 
notification and escalation processes. It handles actions initiated through the user interface or 
through the Hyperic Web Service API. (Figure 4.2.2.1-1) 

4.2.2.1.3 User Interface 

Hyperic provides a rich user interface for browsing inventory, viewing and visualizing metrics, 
and managing your monitoring and alerting logic. The user interface home page, the Dashboard, 
provides an overview of the software inventory changes, problem resources, recent alerts, and 
metric charts. 

4.2.2.1.4 Plugins 

Hyperic capabilities can be extended with two types of plugins 

1. Resource plugin - can be used to discover, monitor, and control software resources. It is 
mainly used for resources that Hyperic does not support. 

2. Extension plugin - can be developed to extend the user interface, develop scripts for 
automating common processes, and develop web services interface with other 
management systems. 

4.2.2.1.5 Hyperic API 

Hyperic also provides a web services API that enables user/plugins to programmatically access 
all Hyperic Server data and functionality. 

4.2.2.1.6 Hyperic Inventory and Access Model 

 

Figure 4.2.2.1-2.  Hyperic Inventory and Access Model 
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Inventory is the sum of all the infrastructure's resources, which includes hosts, operating 
systems, applications servers and their components, and other software. 

Hyperic auto-discovers and classifies different resources into a hierarchy structure: platform, 
server, and service. (Figure 4.2.2.1-2 section A) 

 Platform is a hosting system (i.e., xxdpl01) 

 Server is a software that runs on a platform (i.e. BMGTDispatcher_OPS) 

 Service is a component that runs in a server (i.e. PostgreSQL DBConnection), or is 
associated with a platform (i.e. SSH, RPC, etc.) 

There are two inventory types which can be configured by real users, (Figure 4.2.2.1-2 section 
B). 

 Application is a set of services. It reflects the performance and availability at the 
application level. 

 Group is a collection of resources. If the resources in a group are of the same type, it is 
called a compatible group. Otherwise, it is a cluster. A compatible group can be 
performed a control actions like start, stop, and restart with a single command on all its 
members. 

Group plays a fundamental part in Hyperic's access model. By grouping resources that should 
have the same access requirements together and mapping groups and Users to Roles. 
Administrators can control a user's access to specific resources in the inventory. These two 
components are introduced in section 4.2.2.2.2. 

4.2.2.2 Hyperic Basic Operations and Capabilities 

4.2.2.2.1 Start/Stop Hyperic Server/Agents 

 Start/Stop Hyperic Server: Hyperic Server is running on host x5iil01v. 

ssh to host x5iil01v 
cd /usr/ecs/OPS/COTS/hyperic/server-5.0.0-EE/bin 
./hq-server.sh start|stop 

Even if Start command is executed successfully from the command line, it will take some time 
for the Hyperic Server to be completely started. 

During the Hyperic Server startup time period, you may see this page first when trying to log in:  
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Figure 4.2.2.2.1-1.  Hyperic Server is Starting up 

Note:  Refresh the page if it freezes (i.e., red warning box). At this point, the Hyperic Server may 
not have started completely.  After a few minutes, perform a restart: 

 Start/Stop Hyperic Agent: Hyperic Agent is installed and runs on each host that is to be 
monitored with Hyperic. 

ssh to host 

cd /usr/ecs/OPS/COTS/hyperic/agent-5.0.0-EE/bin 

./hq-agent.sh start|stop|restart|status|dump|ping|setup 

4.2.2.2.2 Users and Roles 

4.2.2.2.2.1  Users 

Hyperic allows customization of user accounts. A user can be assigned a role to manage access 
to resources. Administrators can configure all user roles (Figure 4.2.2.2-1). 

 

Figure 4.2.2.2.2-1.  List/Create Users and Roles  
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Figure 4.2.2.2.2-2.  Add New User Page  

To configure a new or existing user, perform the following:  

 List Users 

Under the Administration tab click on "List Users" (Figure 4.2.2.2.2-1) 

 Create a User 

Step 1: Click "New User" (Figure 4.2.2.2.2-1). 
Step 2: Input New User information then select "Ok & Assign User To Roles". 

4.2.2.2.2.2 Roles 

A role in Hyperic is defined as a permission level to a resource as Full, Read-Write, Read or 
None. The system has been designed in such a way as to shorten the actual process of assigning 
permissions to roles. An administrator creates roles to limit a user's permission to view, monitor, 
modify, create, or control resources within Hyperic. 

NOTE:  In Hyperic, the permission assigned to an inventory type creates a distinction between 
the right to manage and create alert definitions. For example, a 'full' permission role allows user 
to create, edit, and view, as well as perform operations for alert definitions on platforms. 

 List Roles 

Under the Administration tab click on "List Roles" (Figure 4.2.2.2.2-3) 

 Create a Role 
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Step 1: Under the Administration tab click on "New Role..." (Figure 4.2.2.2.2-1)  

 

Figure 4.2.2.2.2-3.  Add New Role  
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Figure 4.2.2.2.2-4.  Role Configuration Page  
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Figure 4.2.2.2.2-5.  Add Users to Role  

Step 2: Complete the New Role form click "Ok" (Figure 4.2.2.2.2-3) 

Step 3: Ensure successful creation of Role, then click button to add users to the Role (Figure 
4.2.2.2.2-4) 

Step 4: Select the users to add to the Role. Users will appear in the left pane. When all desired 
users have been added to the Role select "Ok" (Figure 4.2.2.2.2-5) 

Step 5: Select the groups to assign to the Role. Only after groups are assigned to a Role, can the 
permission of that Role be applied properly. (Refer to 4.2.2.2.8 Groups) 

4.2.2.2.3 Auto-Discovering Resources 

Auto-discovery is a feature where Hyperic collects resource-specific details about an 
environment. This feature will discover all resources running on a host which includes operating 
systems (platforms), servers, and services. An auto-discovery list is created and displayed on the 
user's dashboard so users can add discovered resources into Hyperic's inventory. Auto-discovery 
scans the environment periodically for new resources and can detect key changes to resources 
that are already in the inventory. 

Step 1: View the dashboard and locate the auto-discovery pane (Figure 4.2.2.2.3-1) 
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Figure 4.2.2.2.3-1.  Dashboard Page 

Step 2: Auto-Discovery will display any new resources (Figure 4.2.2.2.3-2). 

 

Figure 4.2.2.2.3-2.  Auto-Discover List  

Step 3: Select the resources to permanently add to the Hyperic Inventory and click "Add to 
Inventory" (or "Skip Checked Resources" to bypass the monitor specific resources). 

Note: When a new custom plugin is deployed it will be auto-discovered and appear in the auto-
discovery pane. Administrators must choose to add the resource to the Hyperic inventory to 
begin monitoring the resource. 

4.2.2.2.4 Add New Resources 

Hyperic provides two ways to add new resources: 

1. Hyperic can auto-discover standard resources it monitors and allow the users to add the 
resources into its inventory through the auto-discover list.  To add a custom resource, the 
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user first needs to generate the custom plugin xml or jar file and deploy it. See section 
1.8, Resource Plugin. Once deployed, Hyperic will auto-discover the resource and put the 
resource in the auto-discover list. 

2. Resources can be manually added to a new platform. The user would go to the Browse 
Resource page, click on "Tool Menu" and select "New Platform". To add a new server or 
service, the user would first select a platform from the Browse Resource page. In the 
platform resource page click on "Tool Menu" and select either "New Server" or "New 
Service". 

Note: Before some resources are added to the Hyperic inventory and can be monitored, required 
configuration must be completed. 

4.2.2.2.5 View Resources 

4.2.2.2.5.1 Viewing a Resource 

Step 1: Select the "Browse" option from the drop-down menu when hovering over the 
"Resources" tab (Figure 4.2.2.2.5-1) 

 

 

Figure 4.2.2.2.5-1.  Resource Browse Link  

Step 2: Select the type of resource (Platform, Server, Service, Compatible Group, Mixed Group, 
and Application) (Figure 4.2.2.2.5-2) 
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Figure 4.2.2.2.5-2.  Choose Resource Type 

Step 3: Select the resource you want to view 

4.2.2.2.5.2 Resource View 

 

Figure 4.2.2.2.5-3.  Resource Tabs 

Monitor Tab 

The monitor tab is the default resource view. The monitor tab allows users to view the 
availability and current metrics being collected for a resource. This view will give insight into 
any problems with the resource. (Figure 4.2.2.2.5-4) 
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Figure 4.2.2.2.5-4.  Resource Monitor Page 

Inventory Tab 

The inventory tab allows a user to view and edit various properties of a resource. 
(Figure4.2.2.2.5-5) 
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Figure 4.2.2.2.5-5.  Resource Inventory Page 

Alert Tab 

The alert tab displays the alert history for a resource. Under this tab a user is able to define a new 
alert or edit an existing one. (Figure 4.2.2.2.5-6) 

 

 

Figure 4.2.2.2.5-6. Resource Alert Page  
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Control Tab 

The control tab displays all of the defined control actions for a resource. A user can manually 
execute a defined control action or schedule one to be executed from the control tab. Under this 
tab a user is also able to define a new control action or edit an existing one. (Figure 4.2.2.2.5-7) 

 

 

Figure 4.2.2.2.5-7. Resource Control Page 

4.2.2.2.6 Alert and Control Actions 

4.2.2.2.6.1  Alert 

An alert is a set of rules that a user defines that tells Hyperic how to detect a problem with a 
given resource. The rules that can be defined for an alert can be: 

 A metric value or event that triggers the alert 

 What to do when the specified measurement or event is reported:  

o Email and SMS notifications 

o Generating OpenNMS traps 

o Escalation schemes 

o Execute a custom script 

o Execute a control action 

o Notify specific Hyperic roles and/or users 

 Creating an Alert 

In order to create an alert for a resource you must create an alert definition that will 
define the conditions that should trigger an alert to fire. 
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Step 1: Navigate to the detailed view of a resource (See section 1.4 View Resource) and 
select the Alert tab. (Figure 4.2.2.2.6-1) 

 

Figure 4.2.2.2.6-1.  Resource Alert Page 

Step 2: Select the "Configure" button (Figure 4.2.2.2.6-2) 

 

 

Figure 4.2.2.2.6-2.  Resource Alert Configure Page  

Step 3: Select the "New..." option (Figure 4.2.2.2.6-3) 
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Figure 4.2.2.2.6-3.  Add New Alert Definition 

Step 4: Complete the Alert Definition Form and Select "Ok" (Figure 4.2.2.2.6-4) 

 

 

Figure 4.2.2.2.6-4. Configure Alert Definition 

4.2.2.2.6.2 Control Actions 

Control actions are user defined actions that can control the status or function of a server or 
service. Actions such as "start", "stop", and "restart" are examples of typical control actions. 
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Hyperic allows users to define their own control actions via custom scripts that are not tied to the 
Hyperic system. 

Creating a Control Action 

See section 4.2.2.4.2.3, Polling Server. 

4.2.2.2.6.3 Recovery Alerts 

In order to automatically mark an alert as fixed once the problem is resolved, a recovery alert 
must be configured.  For details on how to configure a recovery alert see section 4.3, Polling 
Server. 

4.2.2.2.6.4 Hierarchical Alerting 

Hierarchical Alerting is a function of Hyperic that would reduce a number of similar alerts from 
firing from a single root cause from a resource hierarchy. The objective of hierarchical alerting is 
to guarantee that the operations teams are not overloaded with multiple alerts resulting from the 
same root cause. 

For example, when a server reports that a resource with an active alert definition is down, 
Hyperic checks whether its parent (platform is the parent of a server, server is the parent of a 
service, etc.) in the resource hierarchy is up or down. Hyperic will then generate an alert in 
accordance with its definition only in the following situations: 

 Whenever the parent is available 

 Whenever the parent is unavailable and there is no active single-condition alert definition 
on its availability 

Disabling the 'Global Alert Properties' section 

Hierarchical alerting is enabled by default. To disable the alerting feature please follow the 
following steps: 

Step 1: Click on the administration tab of the Hyperic home. (Figure 4.2.2.2.6-5)  

 

Figure 4.2.2.2.6-5.  Hyperic Main Page 
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Figure 4.2.2.2.6-6.  Hyperic Administration Page 

Step 2: Click on the HQ Server Settings on the Hyperic Administration Page. (Figure 
4.2.2.2.6-6) 

Step 3: On the Edit HQ Server Settings page find the Global Alert Properties section. (Figure 
4.2.2.2.6-7) 

 

Figure 4.2.2.2.6-7.  Editing the HQ Server Settings 
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Step 4: To disable the Hierarchical Alerting simply select the OFF radio button of the 
Hierarchical Alerting field and click on OK to save the changes. 

The change takes effect immediately without need to restart the Hyperic Server. The setting will 
persist through Hyperic Server restarts. 

When hierarchical alerting is enabled, Hyperic will process alerts as described above, leveraging 
its built-in knowledge of how each resource fits into Hyperic's three-level (platform-server-
service) inventory model without requiring additional configuration. 

4.2.2.2.6.5 Alert Notification Throttling 

You can configure the Hyperic Server to throttle back alert notifications if there are myriad of 
alerts generated. You can thus configure a maximum number of notifications that Hyperic will 
issue within a fifteen second interval. When that threshold is reached, Hyperic will stop sending 
individual alert notifications. Instead, Hyperic will send a rollup notification to designated 
notification recipients. Hyperic continues to evaluate alert volume, and continues to throttle 
notifications until alert volume decreases sufficiently. Rollup notification e-mails are sent every 
10 minutes and indicate whether or not throttling will continue. 

Enabling Alert Notification Throttling 

Step 1: Click on the administration tab of the Hyperic home. (Figure 4.2.2.2.6-8)  

 

Figure 4.2.2.2.6-8.  Hyperic Main Page 

Step 2: Click on the HQ Server Settings on the Hyperic Administration Page. (Figure 
4.2.2.2.6-9)  
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Figure 4.2.2.2.6-9.  Hyperic Administration Page 

Step 3: On the Edit HQ Server Settings page find the Notification Throttling Configuration 
Properties section. (Figure 4.2.2.2.6-10) 

Step 4: To turn on the feature, Under the Notification Throttling Configuration Properties click 
on the ON radio button under the Notification Throttling. Once that has been selected, one can 
select the maximum number of individual notifications per 15 second interval, and can also 
specify email addresses as to where those notifications should be sent. 
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Figure 4.2.2.2.6-10.  Editing the HQ Server Settings 

4.2.2.2.7 Configuration Tracking 

Configuration tracking notifies users of changes of selected files within an environment. This 
feature continuously compares an original version of a file with the current version to see if any 
changes have occurred. An alert can be triggered when a file is changed. The files that are 
tracked by Hyperic must have the appropriate permissions to allow the Hyperic agents to access 
them. Also, resources that are capable of configuration tracking are usually limited to platform or 
server types. 

4.2.2.2.7.1 Enable and Configure “Configuration Tracking” for a resource 

Step 1: Follow the steps to view a resource and select the "Inventory" tab. (Figure 4.2.2.2.7-1) 
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Figure 4.2.2.2.7-1.  Configuration Tracking Inventory Tab 

Step 2: Scroll down the page to the Configuration Properties section and select "Edit..." (Figure 
4.2.2.2.7-2) 

 

Figure 4.2.2.2.7-2.  Configuration Properties 

Step 3: Follow the instruction on Configuration Tracking page to complete the form. (Figure 
4.2.2.2.7-3)  
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Figure 4.2.2.2.7-3.  Configuration Properties Form 

NOTE: Although custom plugins have been defined to track configuration files it will not occur 
automatically when the plugin is deployed.  The user must manually accept the configuration 
properties through the Hyperic UI the enable configuration tracking. 

4.2.2.2.7.2 Configure “Configuration Tracking” Alert 

Step 1: Follow the steps to create a new Alert 

Step 2: Select the alert condition "Config change and match file name" (Figure 4.2.2.2.7-4) 
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Figure 4.2.2.2.7-4.  Configuration Tracking Alert 

4.2.2.2.8 Groups 

Groups in Hyperic allow users to create collections of resource. This feature is useful when 
resources have a relationship to each other. Business Processes will be created via the group 
feature. A business process will be defined by creating a group assigning all resources that are 
members of the business process to the group. The business process can later be configured at 
the Business Process Configuration page. 

Creating a New Group 

Step 1: Under the Resource Tab expand the "Tools Menu" and Select "New Group" (Figure 
4.2.2.2.8-1) 
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Figure 4.2.2.2.8-1.  Selecting New Group 

Step 2: Complete the New Group form and Select "Ok"(Figure 4.2.2.2.8-2) 

 

 

Figure 4.2.2.2.8-2.  Configuring New Group 

Note: When creating a business process you must prefix the group name with 
"BP_<Mode>_<Business Process Name>" 

Step 3: Ensure successful creation of group and select the button to add resources to the group. 
(Figure 4.2.2.2.8-3) 
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Figure 4.2.2.2.8-3.  Group Inventory Page 

Step 4: Select the resources you want to include in the group. Add them to the group so that they 
show up in the right pane. When all desired resources have been added to the group select "Ok" 
(Figure 4.2.2.2.8-4) 

 

 

Figure 4.2.2.2.8-4.  Add Resource To Group 
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4.2.2.2.9 Escalation Scheme 

An escalation is a type of alert action that contains a notification procedure that is triggered when 
an alert fires. An escalation scheme can define various steps to execute during the lifetime of an 
alert. When the alert is marked as "fixed" the escalation scheme will discontinue. 

 

Creating an Escalation Scheme 

Step 1: Under the Administration tab select "Escalation Scheme Configuration"  

 

Figure 4.2.2.2.9-1.  Escalation Scheme Configuration Link 

Step 2: Complete the form to define a new escalation scheme 
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Figure 4.2.2.2.9-2.  Escalation Scheme Configuration Page 

Step 3: Create escalation scheme action by selecting "Create Action"  

 

Figure 4.2.2.2.9-3.  Escalation Scheme Create Action Link 

Step 4: Select the notification method and notification recipients 
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Figure 4.2.2.2.9-4.  Escalation Scheme Configure Notification 

Step 5: Choose the wait interval and select "Save" at the bottom of the screen 

 

Figure 4.2.2.2.9-5.  Escalation Scheme Configure Wait Interval 
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4.2.2.2.10 Setting Default Metrics Collections 

For most resource types the user will want to configure the same metrics collections for all 
resources of that type.  This is accomplished by using the monitoring defaults 
configuration.  Any new resource added of that type will automatically monitor according to the 
default configuration.  The user should be aware that modifying the defaults will overwrite any 
existing metrics collection configuration for every resource of that type. 

Modifying metric templates for a resource type  

 

Step 1: Under the Administration tab select "Monitoring Defaults"  

 

Figure 4.2.2.2.10-1.  Monitoring Defaults Link 

Step 2: Locate the resource type to configure in the list and select 'Edit Metric Template' 



 4.2.2-31 609-EED-001, Rev. 03 

 

Figure 4.2.2.2.10-2.  Monitoring Defaults Configuration Page - Edit Metric 
Template 

Step 3: Select the metrics to be captured for all resources of that type, choose the collection 
interval for those metrics, and then click the play icon. 
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Figure 4.2.2.2.10-3.  Default Metrics Collection Configuration 

Step 4: Select all of the metrics which are captured to also be indicators (They will be displayed 
graphically when navigating to any resource of that type). 
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Figure 4.2.2.2.10-4.  Default Metrics Collection Configuration - Set Indicators 

4.2.2.2.11 Setting Default Alerts 

For most resource types the user will want to configure the same alerts for all resources of that 
type.  This is accomplished by using the monitoring defaults configuration.  Any new resource 
added of that type will automatically inherit the default alert configuration.  The user should be 
aware that modifying the defaults will overwrite any existing alerts configuration for every 
resource of that type. 

Modifying the alerts for a resource type  

Step 1: Under the Administration tab select "Monitoring Defaults"  
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Figure 4.2.2.2.11-1.  Monitoring Defaults Link 

Step 2: Locate the resource type to configure in the list and select 'Edit Alerts'  
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Figure 4.2.2.2.11-2.  Monitoring Defaults Configuration Page - Edit Alerts 

Step 3: Choose to create a new alert.  

 

Figure 4.2.2.2.11-3.  Create New Alert for Resource Type 

Step 4: Create the alert using the instructions provided in section 4.2.2.2.6.  Be sure to create a 
recovery alert for each alert.  See the figure below for an example of what the page should look 
like after configuring the alert and recovery alert. 
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Figure 4.2.2.2.11-4.  Linux Platform Alert Definitions Example 

4.2.2.2.12 Dashboard 

The dashboard serves as a management tool to observe the overall health of a system. Users can 
organize the screen to correspond to their workflow or infrastructure. By default, the screen 
displays information about resource health, recent alerts, recently performed auto-discovery 
scans, and control actions. 

The Dashboard is a collection of user-selected portlets. Each portlet contains different types of 
data. Users can choose which portlet to display, the location of each portlet, and the type of data 
they display. The data portlets displayed in the Dashboard is determined by the user's role. 
Administrators are able to configure role-based dashboards.  
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Figure 4.2.2.2.12-1.  Dashboard 

A new user can have access to multiple dashboards when logging into Hyperic. One can also 
select his or her personal dashboard, which is his or her default dashboard until he or she 
explicitly designates a different dashboard to be the default. A user with access to multiple 
dashboards may select a different dashboard. When a dashboard other than the user's default is 
active it can be converted as to make the current dashboard the default. 

A user with modify permissions to multiple dashboards can add a resource, or save a chart, 
multiple dashboards with a single command, as outlined below. A user with modify permissions 
to more than one Dashboard can select multiple Dashboards and add the resource to each. Such 
users can also, when viewing a metric chart, select multiple Dashboards and add the chart to 
each. 

Selecting a different dashboard/Changing the default dashboard to default 

Step 1: Under the Dashboard tab select the pull down list 'Select a Dashboard', and pick the 
Dashboard that you want to change the current one with  
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Figure 4.2.2.2.12-2.  Selecting a Different Dashboard 

Step 2: When a new dashboard has been selected, a green button will appear right next to the 
dropdown list of dashboards. Clicking on the Make Default button will make the currently 
selected dashboard default. 

 

Figure 4.2.2.2.12-3.  Changing the Default Dashboard 

Adding a resource or a metric chart to a dashboard 

Step 1: It is possible to add a resource, or save a chart from a resource or server metric to a 
dashboard. To achieve that open a desired resource from the Resources tab 
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Figure 4.2.2.2.12-4.  Selecting a Desired Resource or Server 

Step 2: Once a resource or a server has been selected and the desired indicator shown, click on 
the 'Tools Menu' button and select 'Add to Dashboard favorites'. This option will add that metric 
to the currently selected dashboard. 

 



 4.2.2-40 609-EED-001, Rev. 03 

 

Figure 4.2.2.2.12-5.  Selecting the Metric to be seen in the Selected Dashboard 

4.2.2.2.13 Resource Plugins 

Hyperic, out of the box, detects and monitors a set of standard Linux resources. For resources 
that are not included in the standard list, resource plugins can be written to discover, monitor, 
and control these resources. Hyperic provides the ability to create two types of resource plugins, 
one is a xml plugin and the other is a java plugin. All plugin filename must end with either "-
plugin.xml" or "-plugin.jar". 

4.2.2.2.13.1 Installing Plugin 

Resource plugins need to be installed on the server and agent. The plugin will be placed in a 
subdirectory called hq-plugin of the server and agent's parent directories. This directory is 
located at /usr/ecs/OPS/COTS/hyperic/hq-plugins. This directory is considered a hot deploy 
folder for the server meaning plugins can be added, updated, or removed without restarting the 
server. Agent does not support hot deployment and must be restarted after a plugin is added, 
updated, or removed. 
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4.2.2.2.13.2 Updating Plugin 

Updating resource plugins requires dropping the plugin in the server and agent's hq-plugin 
directories and restarting the agent. When adding new metrics, the operator will need to go to the 
resource page and configure the collection interval for each metric. 

4.2.2.2.13.3 Removing Plugin 

Removing custom plugins requires first removing the resource from the Hyperic GUI, second 
removing the plugin from the hq-plugin directory, and lastly restarting the agent. 

4.2.2.2.13.4 Standard Metrics 

Every custom resource plugin will be deployed with a set of standard metrics. These metrics will 
serve to provide general information pertaining to a resource. The general information is useful 
in measuring the overall health of a resource quickly. The standard metrics consist of 
Availability, CPU Usage, Memory Size, Resident Memory Size, and Start Time. Detailed 
information about each metric can found in the table below.  

Table 4.2.2.2.13-1. Resource Plugin Standard Metrics 
Standard Metrics 

Metric Name Description 

Availability  

The Availability metric indicates whether a Resource is up or down. 
 
A metrics-gathering plugin must determine Availability for every server 
and every service it monitors. A single plugin will likely gather 
Availability for multiple Resources. If Availability is not gathered for a 
Resource, HQ will consider the Resource to be unavailable, and will 
not show any metrics for it in the Portal. 
 
A plugin sets the value of Availability to 1 if the Resource is up, and 0 
if it is down. These values are displayed in the Portal as "available" or 
"not available". 
Verifying the existence of a Resource's process is a common 
technique for determining its Availability. However, the method a 
plugin uses to determine Availability can vary depending on the 
Resource Type and the plugin developer's judgment. There might be 
alternative techniques for determining the Availability of a Resource. 
For instance, a plugin might determine the Availability of a web server 
based on whether its process is up, its port is listening, it is responsive 
to a request, or by some combination of these conditions. 

CPU Usage 
The percentage of time the specified resource uses in processing 
instructions. 

Memory Size The amount of memory allocated to the specified resource. 

Resident Memory Size The amount of RAM being consumed by the specified resource. 

Start Time The time the specified resource was instantiated 
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4.2.2.2.14 User Interface Extension Plugin 

Hyperic provides an HQU plugin framework which allows custom user interfaces to be 
developed and plugged right into the Hyperic GUI. The HQU plugins have the ability to directly 
access the entire Hyperic backend and utilize Hyperic's API. HQU plugins are developed in 
Groovy, an Object-Oriented scripting language alternative to Java. Groovy files are compiled 
into byte code and run in the JVM and can interact with Java classes and libraries. 

4.2.2.2.14.1 HQU Plugin Directory Structure 

 

Figure 4.2.2.2.14-1.  HQU Plugin Structure Diagram 

Table 4.2.2.2.14-1.  HQU Plugin Structure Description 
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4.2.2.2.14.2 HQU Plugin MVC Framework 

HQU plugins utilize a Model View Controller framework to manage the user interface. The 
model is provided by the Hyperic backend, the view is composed of html with groovy and 
javascript elements, and the controller handles the communication between the view and model. 

 

Figure 4.2.2.2.14-2.  MVC Framework 

Model 

The Model represents the business logic and can be accessed through the uses of Hyperic's 
backend API. The API is written in Java and allows users and developers to create, retrieve, 
update, and delete information stored in Hyperic. 

View 

The View, a gsp file, is comprised of HTML, JavaScript, and groovy. It is responsible for 
rendering the content in the Hyperic GUI. The HTML provides the structure of the file. The 
JavaScript component provides interaction between the user and user interface. AJAX techniques 
are used to process requests and distribute data to the screen. The view invokes methods defined 
in the controller via AJAX requests to obtain information maintained in the Hyperic backend. 
HQU Plugins use an internet rich application toolkit called Dojo. The Dojo toolkit coordinates 
the AJAX requests and it helps process responses. Responses to AJAX requests are returned in 
JSON (JavaScript Object Notation) format. JSON is a light weight data interchange format 
similar to XML but can be decoded into JavaScript objects easily. 

Controller 

The controller is written using the groovy scripting language and the file ends with the .groovy 
extension. The controller is responsible for coordinating the activities between the model and 
view. The view submits a request to the controller. The controller decodes the request and calls 
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the Hyperic backend API (the model) to perform some task. The result returned from the model 
is than transferred from the controller to the view to be rendered. 

4.2.2.2.14.3 Installing HQU Plugin 

Hyperic is bundled with the Tomcat web application server. Installing the HQU plugins involves 
copying the necessary files to the HQU directory located in the Tomcat web application 
deployment directory, /usr/ecs/OPS/COTS/hyperic/server-5.0.0-EE/hq-engine/hq-
server/webapps/ROOT/hqu. The Hyperic server does not need to be restarted. Hyperic supports 
hot HQU plugin deployment. 

4.2.2.2.14.4 Updating HQU Plugin 

Updating an HQU plugin requires removing the plugin through the HQU Plugin Manager page. 
The page is located under the administration section of the Hyperic GUI. Once removed, copy 
the plugin into the TOMCAT web application deployment directory and the plugin will be 
updated automatically. 

4.2.2.2.14.5 Removing HQU Plugin 

Removing a plugin requires going to the HQU Plugin Manager page and remove the plugin from 
the list.  The plugin will be automatically removed. 

4.2.2.2.15 Hyperic ingrained metric data state definitions 

Hyperic has ingrained metric data that can be monitored for specific services such as HTTP, 
FTP, NTP, and more. One can obtain those metrics by going to the individual service, and 
invoking those states by going to the Metric data tab under the Monitor general tab, and clicking 
on Show All Metrics button. Some of the most common metrics are displayed below: 

HTTP Throughput States 

Once a connection has been initialized it goes thru a series of states, which can be seen in the 
table below: 

Table 4.2.2.2.15-1.  HQU Plugin Structure Description (1 of 2) 
CLOSE represents no connection state at all 

CLOSE_WAIT represents waiting for a connection termination request from the local user 

CLOSING represents waiting for a connection termination request acknowledgment 
from the remote TCP 

ESTABLISHED represents an open connection, data received can be delivered to the user. 
The normal state for the data transfer phase of the connection 

FIN_WAIT1 represents waiting for a connection termination request from the remote 
TCP, or an acknowledgment of the connection termination request 
previously sent 

FIN_WAIT2 represents waiting for a connection termination request from the remote 
TCP 

LAST_ACK represents waiting for an acknowledgment of the connection termination 
request previously sent to the remote TCP (which includes an 
acknowledgment of its connection termination request) 
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Tabie 4.2.2.2.15-1.  HQU Plugin Structure Description (2 of 2) 
SYN_RECV represents waiting for a confirming connection request acknowledgment 

after having both received and sent a connection request 

SYN_SENT represents waiting for a matching connection request after having sent a 
connection request 

TIME_WAIT represents waiting for enough time to pass to be sure the remote TCP 
received the acknowledgment of its connection termination request 

Response Code A utilization metric representing the number of HTTP Response codes 
thrown in the current active session 

A connection progresses from one state to another in response to a certain event. Those events 
are usually user calls, incoming segments, and timeouts. 

For more detailed picture of the states, please consider the following figure below: 



 4.2.2-46 609-EED-001, Rev. 03 

 

Figure 4.2.2.2.15-1.  MVC Framework 

Copyright: Internet Engineering Task Force 

The starting point of the process is the closed state, from where a process is initialized. Each 
arrow represents a relationship between the next state and how the transition is made. 



 4.2.2-47 609-EED-001, Rev. 03 

Table 4.2.2.2.15-2.  HQU Plugin Structure Description 
DNS Metrics 

Metric Definition

Answers The number of records that the server answers to queries 

Authority Records The number of valid domain records that the server answers to 
queries 

Additional Records The number of other records that hold additional information, that 
the server answers to queries 

Table 4.2.2.2.15-3.  HQU Plugin Structure Description 
NTP Metrics 

Metric Definition

Local Clock Offset UTC Time is estimated by all the peer clocks (servers on the UTP 
network). NTP continually modifies the clock rate on the local 

system in an attempt to bind the local clock offset from UTC. The 
offset of the rest of the systems is known as Local Clock Offset 

Response Time The Response Time it takes to reach the UTC server, when there 
is a query instantiated from a server on the network 

Root Delay Round trip delay between the server and the (root) NTP server 

Root Dispersion Measurement of all the errors associated with the network hops 
and servers between the server and its clients 

Round Trip Delay The delay of a NTP packet sent from the NTP server to a client 

4.2.2.3 Configure Resources 

Section 4.2.2.2 described how Hyperic provides the capability of adding resources to its 
inventory to monitor. This section shows how to add and/or configure some common resources 
using Hyperic. 

4.2.2.3.1 Configuring Tomcat 

Hyperic will auto-discover Tomcat instances running on a platform but requires some 
modifications to Tomcat for monitoring to take place.  Hyperic gathers metrics from Tomcat via 
JMX.  Thus Tomcat needs to be configured to gather these metrics and allow these metrics to be 
retrieved via JMX. The following steps will accomplish this. 

1. Log onto Tomcat web server host 

2. cd /usr/ecs/OPS/COTS/tomcat/bin 

3. Save off a copy of the tomcatENV.sh file 

4. Editing  the tomcatENV.sh file do the following  

1. remove the double quote at the end of -XX:PermSize=512m \" 
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2. add the following  the following bolded lines  
1. -Dcom.sun.management.jmxremote \ 
2. -Dcom.sun.management.jmxremote.port=6969 \ 
3. -Dcom.sun.management.jmxremote.ssl=false \ 
4. -Dcom.sun.management.jmxremote.authenticate=false" 

The file should look like the following: 
 
#!/bin/sh 
# 
#   
ECS_HOME=/usr/ecs 
JAVA_HOME=/usr/ecs/OPS/COTS/jdk 
CATALINA_OPTS="-DECS_HOME=/usr/ecs -DARCH= -ms245m -mx512m -
XX:MaxPermSize=512m -XX:PermSize=512m \ 
-Dcom.sun.management.jmxremote \ 
-Dcom.sun.management.jmxremote.port=6969 \ 
-Dcom.sun.management.jmxremote.ssl=false \ 
-Dcom.sun.management.jmxremote.authenticate=false" 
 
umask 002 
 
export ECS_HOME JAVA_HOME CATALINA_OPTS 
  

5. Stop and restart the tomcat server 

6. Using the Hyperic GUI, drill down to the tomcat instance running on a given platform 
using the Resource->Browse screen.  The screen should look like the following 
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Figure 4.2.2.3.1-2.  Tomcat Monitor Page 

  

7. Click the Inventory button.  The following screen should look similar to the following 
screen when the user scrolls to the bottom. Click the EDIT button in the Configuration 
Properties section. 
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Figure 4.2.2.3.1-3.  Tomcat Inventory Page 

  

8. The next screen prompts for information to needed by Hyperic to monitor  the Tomcat 
server.  Fill in the following fields 

jmx.url: service:jmx:rmi:///jndi/rmi://<hostname>:6969/jmxrmi 
jmx.username: system (default) 
jmx.password: leave blank 
ptql-State.Name.eq=java,Args.*.ct=catalina.home,CredName.User.eq=tomcat 
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Figure 4.2.2.3.1-4.  Tomcat Configuration Page 

  

9. Click "OK" button. 

10. After a few minutes, the Tomcat server monitor page should appear similar to the 
following. 
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Figure 4.2.2.3.1-5.  Tomcat Configured Monitor Page 

** If the only metric that is of concern is if the server is up or down, DAACs may consider using 
the HTTP service to ping a url instead.  Details on how to configure an HTTP service are 
described in the setup of the Oracle iPlanet Web Server configuration. 

4.2.2.3.2 Configuring xinetd 

Hyperic does not provide a service that explicitly monitors the xinetd service but it does provide 
the ability to monitor a process.  This may be accomplished by following the following steps. 

1. Choose the host platform that you want to monitor the xinetd service – xxeil01 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following 
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Figure 4.2.2.3.2-1.  Host Resource Page 

  

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 
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Figure 4.2.2.3.2-2.  Add New Platform Service 

4. The following screen appears.  Fill in the following fields 

name: the name of the service ex "xinetd xxhel01" 

description: the description of the service 

(ex. "Monitors the xinetd service on xxhel01") 

service type: choose Process from the drop down menu 

 

Figure 4.2.2.3.2-3.  Configure xinetd 
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5. Click "OK" button 

6. The next screen allows for the configuration of the Process service.  In the following 
screen, hit the EDIT button in the Configuration Parameters panel. 

  

 

Figure 4.2.2.3.2-4.  xinetd Inventory Page 

7. The next screen allows the user to define how to "find" the process.  Hyperic uses what it 
refers to as PTQL(Process Table Query Language) to identify a process.  To find the 
xinetd process enter the following: 

process.query: Pid.PidFile.eq=/var/run/xinetd.pid 

The Pid.PidFile.eq=/var/run/xinetd.pid tells Hyperic that it can find the pid associated 
with the xinetd process within the file /var/run.xinetd.pid 

For detailed information about PTQL visit the Hyperic site 
http://support.hyperic.com/display/SIGAR/PTQL 
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Figure 4.2.2.3.2-5.  xinetd Configuration Page 

8. Click "OK" button 

9. After a few minutes, the xinetd xxhel01 service monitor page should appear similar to the 
following. 
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Figure 4.2.2.3.2-6.  xinetd Configured Monitor Page 

4.2.2.3.3 Configuring DNS 

Monitoring a DNS service works by configuring a Hyperic DNS service.  This service will 
perform a DNS lookup to the DNS service and comparing the return with an expected answer. 
To configure a Hyperic DNS service, perform the following steps. 

1. Choose a host platform to create the Hyperic DNS service – xxeil01 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The screen 
should look like the following 
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Figure 4.2.2.3.3-1.  DNS Monitor Page 

3. From this screen choose from the Tools Menu (upper left) the New Platform Service 
link.  
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Figure 4.2.2.3.3-2.  Add New Platform Service 

4. The following screen appears.  Fill in the Name, Description, and choose DNS from the 
Service Type drop down menu.  

 

Figure 4.2.2.3.3-3.  Confgure DNS 
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5. The next screen allows for the configuration of the DNS service.  In the following screen, 

hit the EDIT button in the Configuration Parameters panel 
  

 

Figure 4.2.2.3.3-4.  DNS Inventory Page 

  
6. Configure the service by populating the following  

 hostname:  host that DNS is running on 

 port: the port number DNS is listening on, typically 53 

 sotimeout: socket timeout, defaults to 10 seconds 

 lookupname: choose a host that your DNS will have an answer for.(ex. 
xxdpl01.edn.ecs.nasa.gov) 

 pattern: perform an nslookup on the host that you chose for lookupname and enter 
the Address. 155.157.31.204 in the below example. 

Example 

- bash-3.2$ nslookup f4iil01 

  Server:         155.157.31.209 

  Address:        155.157.31.209#53 

  Name:   f4iil01.edn.ecs.nasa.gov 

  Address: 155.157.31.204 

type: choose A from the drop down menu  
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Figure 4.2.2.3.3-5.  DNS Configuration Page 

  
7. Click "OK" button 
8. After a few minutes, the DNS-NS2 service monitor page should appear similar to the 

following. 
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Figure 4.2.2.3.3-6.  DNS Configured Monitor Page 

4.2.2.3.4 Configuring ssh 

Monitoring a host's SSH service works by configuring a Hyperic SSH service. This service will 
secure shell with a configured username and password. The success of the secure shell along 
with the response time will be stored as metrics.  To configure a Hyperic SSH service perform 
the following steps. 

1. Choose a host platform to create the Hyperic SSH service – xxeil01. 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following. 
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Figure 4.2.2.3.4-1.  Host Resource Page 

  

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 
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Figure 4.2.2.3.4-2.  Add New Platform Service 

4. Choose a host platform to create the Hyperic SSH service – xxeil01 

5. The following screen appears.  Fill in the following 

name: Choose a name such as SSH xxdpl01 
description:  Choose a description such as "checks ssh on xxdpl01 host" 
service type: From the drop down menu choose SSH 
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Figure 4.2.2.3.4-3.  Configure ssh 

6. Click "OK" button. 

7. The next screen allows for the configuration of the SSH service. Hit the Edit button in the 
Configuration Properties section. 

  

 

Figure 4.2.2.3.4-4.   ssh Inventory Page  

8. Fill in the following fields on the next screen 

hostname: The host whose ssh service is being monitored 
port: The ssh port number, typically 22 
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sotimeout: The socket timeout, typically 10 seconds 
user: The user name to log into the host via ssh 
pass: The password for the user 
 
**NOTE the pass value will need to be updated every time the password is changed for 
the user 

 

Figure 4.2.2.3.4-5.  ssh Configuration Page 

9. Click "OK" button. 

10. After a few minutes, the SSH-xxdpl01 service monitor page should appear similar to the 
following page. 
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Figure 4.2.2.3.4-6.  ssh Configured Monitor Page 

4.2.2.3.5 Configuring Oracle iPlanet Web Server (formerly Sun Java Web 
Server) 

The monitoring of Sun Java System Web Server, now known as the Oracle iPlanet Web Server, 
may be accomplished by creating a service that pings a configured url.  To configure a Hyperic 
http service perform the following steps 

1. Choose a host platform that is running the Web Server – xxdpl01 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following 
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Figure 4.2.2.3.5-1.  Host Resource Page 

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 
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Figure 4.2.2.3.5-2. Add New Platform Service 

4. The following screen appears.  Fill in the following 

name: choose a name such as Sun Web Server 7 xxdpl01 
description: choose a description such as "Monitors Sun Web Server 7 on xxdpl01 host" 
service type: Choose from the drop down menu - choose HTTP 
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Figure 4.2.2.3.5-3.  Configure Sun Java System Web Server 

5. Click "OK" button. 

6. The next screen allows for the configuration of the HTTP service. Hit the Edit button in 
the Configuration Properties section. 

 

Figure 4.2.2.3.5-4.  Sun Java System Web Server Inventory Page 
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7. Fill in the following fields on the next screen 

hostname: the host of the Sun Web Server 7 being monitored 
port: the port number 
sotimeout: the socket timeout, typically 10 seconds 
path: leave as / 

 

Figure 4.2.2.3.5-5.  Sun Java System Web Server Configuration Page 

8. Click "OK" button. 

9. After a few minutes, the HTTP-xxdpl01 service monitor page should appear similar to 
the following page. 
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Figure 4.2.2.3.5-6.  Sun Java System Web Server Configured Monitor Page 

**The Hyperic application is supposed to be able to monitor the Sun Web Server via SNMP 
which would provide more detail about the status of the server.  However, as of the writing of 
this document, having the Sun Web Server gather metrics and make them available via SNMP 
has not been successful.  

4.2.2.3.6 Configuring SendMail 

Hyperic will auto-discover Sendmail instances running on a platform but requires some 
modifications for the Sendmail monitoring to take place.  Hyperic gathers metrics by running a 
script which will try to cd into the directories /var/spool/mqueue and /var/spool/clientmqueue 
and list the contents.  Hyperic will need permission to cd into these directories and perform an ls. 
The following steps will accomplish this. 

On the mail server host: 
 
xxeil01# ls -ld /var/spool/*queue 
drwxrwx--- 2 smmsp smmsp  4096 Sep  9 04:05 /var/spool/clientmqueue 
drwx------ 2 root  mail  20480 Sep  9 10:21 /var/spool/mqueue 
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xxeil01# chmod 750 /var/spool/mqueue 
 
xxeil01# ls -ld /var/spool/*queue 
drwxrwx--- 2 smmsp smmsp  4096 Sep  9 04:05 /var/spool/clientmqueue 
drwxr-x--- 2 root  mail  20480 Sep  9 10:21 /var/spool/mqueue 
 
xxeil01# vi /etc/group  (add hyperic to "mail" and "smmsp" groups) 
mail:x:12:mail,hyperic 
smmsp:x:51:hyperic 
 
After a few minutes, the xxeil01 Sendmail 8.x  monitor page should appear similar to the 
following page.  

 

Figure 4.2.2.3.6-1.  SendMail Monitor Page 

**Detailed instructions will be issued concerning the permission changes. 
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*** Do not follow the instructions provided by Hyperic for the configuration of Sendmail. Their 
instruction was to give sudo/NOPASSWD such that the script will execute as root without a 
password which EED system administrators strongly discouraged. 

***Sendmail should only be auto-discovered on the xxeil01 host. 

4.2.2.3.7 Configuring StorNext Host Monitoring 

Quantum, the makers of StorNext, recommend against any other software being installed on the 
metadata host. Thus, an agent will not be installed and the only monitoring will be a ping of the 
virtual StorNext metadata host.  Hyperic provides the ability to ping a host.  The following steps 
will accomplish this. 

1. Choose a host platform that can ping the xxsmvaa host. 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following. 

 

Figure 4.2.2.3.7-1.  Host Resource Page 

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 
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Figure 4.2.2.3.7-2.  Add New Platform Service 

4. The following screen appears.  Fill in the following 

name: choose a name such as StorNext Metadata Host Ping 
description: choose a description such as "This service will ping the metadata host" 
service type: From the drop down menu - choose InetAddress Ping  
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Figure 4.2.2.3.7-3.  Configure StorNext Host Monitoring 

5. Click "OK" button. 

6. The next screen allows for the configuration of the ping service.  Click the Edit button in 
the Configuration Properties section 

 

Figure 4.2.2.3.7-4.  StorNext Host Monitoring Inventory Page 

7. Fill in the following fields on the next screen. 

hostname: the virtual host name (ex. p4smvaa) 
sotimeout: the socket timeout, typically 10 seconds 
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Figure 4.2.2.3.7-5.  StorNext Host Monitoring Configuration Page 

8. Click "OK" button. 

9. After a few minutes, StorNext Metadata host ping service monitor page should appear 
similar to the following page. 
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Figure 4.2.2.3.7-6.  StorNext Host Monitoring Page 

4.2.2.3.8 Configuring NIS 

Hyperic does not provide a service that explicitly monitors the Network Interface Service (NIS) 
but it does provide the ability to monitor a process.  We can use the process monitoring 
capability to monitor NIS clients and server. 

The NIS client should be running on every host platform within the EED system. For each host 
platform, follow the following steps to configure the NIS client monitoring: 

1. Choose the host platforms that you want to monitor the NIS cient, e.g x4hel01. 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following. 
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Figure 4.2.2.3.8-1.  Host Resource Page 

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 
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Figure 4.2.2.3.8-2. Add New Platform Service 

4. The following screen appears.  Fill in the following fields 

name: the name of the service ex "NIS client x4hel01" 
description: the description of the service 
(ex. "Monitor NIS client on x4hel01") 
service type: choose Process from the drop down menu 
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Figure 4.2.2.3.8-3.  Configure NIS client 

5. Click "OK" button 

6. The next screen allows for the configuration of the Process service.  In the following 
screen, hit the EDIT button in the Configuration Parameters panel. 

 

Figure 4.2.2.3.8-4.  NIS client Inventory Page 

7. The next screen allows the user to define how to "find" the process.  Hyperic uses what it 
refers to as PTQL (Process Table Query Language) to identify a process.  To find the NIS 
client process enter the following: 
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process.query: Pid.PidFile.eq=/var/run/ypbind.pid  
The Pid.PidFile.eq=/var/run/ypbind.pid tells Hyperic that it can find the pid associated 
with the NIS client process within the file /var/run/ypbind.pid 
For detailed information about PTQL visit the Hyperic site 
http://support.hyperic.com/display/SIGAR/PTQL  

 

Figure 4.2.2.3.8-5.  NIS client Configuration Page 

8. Click "OK" button 

9. After a few minutes, the NIS client x4hel01 service monitor page should appear similar 
to the following: 
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Figure 4.2.2.3.8-6.  NIS client Configured Monitor Page 

The NIS server can be monitored in a similar fashion: 

1. Choose the host platform that NIS server resides on, e.g. x4nsl01 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following. 
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Figure 4.2.2.3.8-7.  Host Resource Page 

3. From this screen choose from the Tools Menu (upper left) the New Platform Service link. 

4. The following screen appears.  Fill in the following fields 

name: the name of the service ex "NIS server x4nsl01" 
description: the description of the service 
(ex. "Monitor NIS server on x4nsl01") 
service type: choose Process from the drop down menu 
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Figure 4.2.2.3.8-8.  Configure NIS Server 

5. Click "OK" button 

6. The next screen allows for the configuration of the Process service.  In the following 
screen, hit the EDIT button in the Configuration Parameters panel. 

 

Figure 4.2.2.3.8-9.  NIS Server Inventory Page 

7. The next screen allows the user to define how to "find" the process.  Hyperic uses what it 
refers to as PTQL(Process Table Query Language) to identify a process.  To find the NIS 
server process enter the following: 
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process.query: Pid.PidFile.eq=/var/run/ypserv.pid  
The Pid.PidFile.eq=/var/run/ypserv.pid tells Hyperic that it can find the pid associated 
with the NIS client process within the file /var/run/ypserv.pid 
For detailed information about PTQL visit the Hyperic site 
http://support.hyperic.com/display/SIGAR/PTQL  

 

Figure 4.2.2.3.8-10.  NIS Server Configuration Page 

8. Click "OK" button 

9. After a few minutes, the NIS server x4nsl01 service monitor page should appear similar 
to the following: 
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Figure 4.2.2.3.8-11.  NIS Server Configured Monitor Page 

4.2.2.3.9 Configuring HTTP 

Hyperic provides an http service to monitor webpage. The service will submit an http request to 
the specified site, parse the http response, and update the status of the webpage in Hyperic. Both 
http and https can be monitored using this service. Follow the following steps to configure 
Hyperic to monitor a webpage: 

1. Select the platform you want to add the http service resource. 

  



 4.2.2-88 609-EED-001, Rev. 03 

 

Figure 4.2.2.3.9-1.  Configure HTTP Pick Platform 

2. Select the "Add New Service" from the drop down list. 

 

Figure 4.2.2.3.9-2.  Configure HTTP Add New Service 
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3. Fill in the requested properties information. 

Name – The name of the http service. 
Description – A description of the http service. 
Service Type – Select the 'HTTP' from the drop down list. 

 

Figure 4.2.2.3.9-3. Configure HTTP General Properties 

4. Next, we need to configure the service to monitor a specific webpage. Select the 
'Configuration Properties' link. 

 

Figure 4.2.2.3.9-4. Configure HTTP Configuration Properties Link 
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5. Fill in the configuration properties and click the 'OK' button. 

ssl (optional) – Check this box if the site communicates via https. 
hostname (required) – The hostname to the webpage. http://<hostname>:<port>/<path> 
port (required) – The port the http service communicates with. Usually http uses port 80 
and https uses 443, but check with the web administrator for the correct port. 
sotimeout (required) – The about of time to wait before timing out the http request. 
path (required) – The path of the webpage. http://<hostname>:<port>/<path> 
user (optional) – Supply the username if one is required. 
pass (optional) – Supply the password if one is required. 
realm (optional) – Supply the realm if one is required. 
method (required) – Select an http request type to submit from the drop down list 
(HEAD, GET, POST, etc.). 
hostheader (optional) – Supply the hostheader if one is required. 
follow (optional) – Check this box if the hostname and path supplied above will redirect 
you to another page. 
pattern (optional) – A pattern or regex that matches the responses from the webpage. 
proxy (optional) – Supply the proxy URL (with the port number appended to the end 
of it) if one is required to access the webpage. See example below. 
Example: 192.121.253.1:80 

 

Figure 4.2.2.3.9-5.  Configure HTTP Configuration Properties 

6. At this point, the http service is configured and the operator can select the 'Inventory' to 
monitor the webpage. The operator can also go to the 'Inventory' tab, select the 'metrics' 
tab', and configure the monitoring interval for the metrics gathered by the http service. 
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4.2.2.3.10 Configuring FTP 

Hyperic provides an ftp service to monitor an ftp site. The service will attempt to login into the 
site. Being able to login, Hyperic will mark the resource (ftp site) as being up. Follow the steps 
below to configure Hyperic to monitor an ftp site: 

1. Select the platform you want to add the ftp service resource. 

 

Figure 4.2.2.3.10-1.  Configure FTP Pick Platform 

2. Select the "Add New Service" from the drop down list. 
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Figure 4.2.2.3.10-2.  Configure FTP Add New Service 

3. Fill in the requested properties information. 

Name – The name of the ftp service. 
Description – A description of the ftp service. 
Service Type – Select the 'FTP' from the drop down list. 
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Figure 4.2.2.3.10-3.  Configure FTP General Properties 

4. Next, we need to configure the service to monitor a specific ftp site. Select the 
'Configuration Properties' link. 

 

Figure 4.2.2.3.10-4.  Configure FTP Configuration Properties Link 

5. Fill in the configuration properties and click the 'OK' button. 
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hostname (required) – The hostname to the ftp site. 
port (required) – The port the ftp site listen on. The default port is 21. 
sotimeout (required) – The about of time to wait before timing out the ftp login attempt. 
user (optional) – Supply the username if one is required. 
pass (optional) – Supply the password if one is required. 

 

Figure 4.2.2.3.10-5. Configure FTP Configuration Properties 

6. At this point, the ftp service is configured and the operator can select the 'Inventory' to 
monitor the webpage. The operator can also go to the 'Inventory' tab, select the 'metrics' 
tab', and configure the monitoring interval for the metrics gathered by the ftp service. 
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Figure 4.2.2.3.10-6.  FTP Monitoring 

4.2.2.3.11 Configuring InetAddress Ping 

Hyperic provides an InetAddress Ping service to monitor a host to determine if it's up or down. 
This is useful for situation where an Hyperic agent can not be installed on the host, but knowing 
if the host is up or down is critical to operations. Follow the steps below to configure Hyperic to 
monitor a host: 

1. Select the platform you want to add the InetAddress Ping service resource. The agent on 
this platform will initiate the ping to the destination host. 
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Figure 4.2.2.3.11-1.  Configure InetAddress Ping Pick Platform 

2. Select the "Add New Service" from the drop down list. 

 

Figure 4.2.2.3.11-2.  Configure InetAddress Ping Add New Service 
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3. Fill in the requested properties information. 

Name – The name of the InetAddress Ping service. 
Description – A description of the InetAddress Ping service. 
Service Type – Select the 'InetAddress Ping' from the drop down list. 

 

Figure 4.2.2.3.11-3.  Configure InetAddress Ping General Properties 

4. Next, we need to configure the service to monitor a specific host. Select the 
'Configuration Properties' link. 

 

Figure 4.2.2.3.11-4.  Configure InetAddress Ping Configuration Properties Link 
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5. Fill in the configuration properties and click the 'OK' button. 

hostname (required) – The hostname to monitor. 
sotimeout (required) – The about of time to wait before timing out the ping. 

 

Figure 4.2.2.3.11-5.  Configure InetAddress Ping Configuration Properties 

6. At this point, the InetAddress Ping service is configured and the operator can select the 
'Inventory' to monitor the webpage. The operator can also go to the 'Inventory' tab, select 
the 'metrics' tab', and configure the monitoring interval for the metrics gathered by the 
InetAddress Ping service. 
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Figure 4.2.2.3.11-6.  InetAddress Ping Monitoring 

4.2.2.4 Business Processes and Configuration 

4.2.2.4.1 Business Processes 

4.2.2.4.1.1 Overview 

Business Processes are a way of organizing resources to quickly recognize problems and to 
assess the operational impact of individual component failures. A custom Hyperic User Interface 
plugin will be developed to extend the standard COTS GUI to provide the operator with a 
mechanism to configure and view their business processes. 

Business processes can have one of four statuses: 

 Active – There is work to do and the work is being completed as expected 

 Inactive – All of the components appear to be functional, but there is not any work to 
complete. 

 Degraded – The business process is functioning but not at the required capacity 

 Down – The business process is unable to complete any work. 

Each business process contains a collection of resources and the resources can have one of three 
statuses: 
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 Available – The resource is currently up 

 Unavailable – The resource is currently down 

 Alert Pending – There is at least one alert pending for the resource 

4.2.2.4.1.2 Configuring Business Processes 

The Hyperic grouping feature will be used to define a business process. All resources related to a 
business process will be mapped to a group. The business process group name must follow the 
naming convention BP_<MODE>_<Business Process Name>. This will allow the custom 
Hyperic HQ User Interface plugin a way to identify a business process group from one that is 
not. 

The information of resource state and metrics are conveyed to the business process through 
alerts. For example, if we decided that the status of the DPL Ingest business process should be 
'Down' if the EcDlProcessingService resource is unavailable, an alert must be configured to 
occur when the processing service is down.  Then the Ingest business process can be configured 
to be 'Down' based on the alert.  

In order to determine which resource alert has an impact on the overall business process status 
and to what degree, each business process has an alert definition configuration file named 
<business_process_name>_AlertDefinitionConfig.xml. The files are located under 
/usr/ecs/OPS/CUSTOM/cfg directory. This xml file holds the configuration information of the 
business processes within the mode and the mapping of the relevant alert definition to the status 
(down, inactive, degraded, active) category of the business process. Not all alerts need to be 
defined in this configuration file, only those that impact the status of the business process. For 
alerts that are raised within a business process that are not defined in the configuration file, the 
priority of the alert is examined and the status of the business process will be defaulted to 
'Degraded' if the alert has a priority of 'Medium' or 'High'. This gives the operator the capability 
to handle newly created alert definitions. 

See below for the xml schema diagram of the business process alert definition configuration file.  
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Figure 4.2.2.4.1-1.  Alert Definition Schema Diagram 

See appendix 2.1 for the schema xml and appendix 2.2 for a sample configuration xml for OPS 
mode. 

Sometime we may want to change the status of a business process when a combination of 
different alerts on different resources happens at the same time. For example, we may want to 
mark the Data Access business process as "degraded" when EWOC or DataDataAccess is down; 
but when both of them are down, we want to mark the Data Access business process as "down". 
Since hyperic does not provide the functionality to configure alerts on incompatible groups, we 
added a custom group alert capability in our Business Process configuration and view pages. 

Operator can configure group alert to be any combination of resource alerts and define how the 
group alert would impact the overall business process status. Each business process could have a 
group alert definition configuration file. If exists, it is named 
<business_process_name>_GroupAlertDefinitionConfig.xml. The configuration files are located 
under /usr/ecs/OPS/CUSTOM/cfg directory. Operator should not manually update the 
configuration files. All update should be done through the hyperic GUI. 

We created a custom HQU Business Process Configuration page to let operators view and 
configure the existing resource alert and group alert definitions with in the system. See 
screenshots below:  
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Figure 4.2.2.4.1-2.  Hyperic GUI Administration Tab 

The Business Process Configuration page will be located under the Administration tab.  

 

Figure 4.2.2.4.1-3.  Hyperic GUI Administration Page 

After clicking on the tab, the administration page is loaded. The business process configuration 
link, "Business Process Configuration" is located under the Plugin section. Click on the link to 
load the page. 
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Figure 4.2.2.4.1-4.  Business Process Configuration Page 

The Business Process Configuration page contains a tab container. Each tab represents an ECS 
mode. Each mode container is divided into two panes and will display mode specific business 
process configuration. The left pane contains a list of business processes. The business process 
highlighted represents the current selection. Selecting a business process in the left pane will 
update the information on the right pane. The right pane contains a list of alert definitions for the 
selected business process. For each item in the list, the alert definition name, the resource name, 
the priority and the status definition is displayed.  The alert definition name is a link to the 
configuration page of the alert definition. The resource name indicates which resource the alert 
definition is associated with and is a link to the detail page of the resource. The priority column 
shows the severity of the alert definition. It can have one of three values - low, medium, or high. 
The status definition shows the mapping of the alert definition to a business process status 
category. It can have one of four values - "Active", "Inactive", "Degraded", or "Down". 

The alert definition configuration files will be loaded for all modes when the Business Process 
Configuration page is loaded or refreshed.  An operator with admin privileges can configure the 
status definition field of each alert to its desired category. Once the operator clicks the "save" 
button at the bottom of the page, the xml configuration file will be updated with the new 
configuration values on the page. 

Operator can configure group alerts by clicking on the "Group Alert Configuration" button on 
the top of the right pane. This will bring up the group alert configuration page, see screen shot 
below: 
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Figure 4.2.2.4.1-5.  Business Processes Group Alert Configuration 

"Alert Configuration" button will lead operator back to the Alert definition page. Operator can 
view existing group alerts, updated group alerts, delete group alerts and create new group alerts 
through the buttons on the page. 

To view an existing group alert, operator can click the drop down list on the top of the page next 
to the MODE. When clicked, the drop down list will list all existing group alerts. Once operator 
makes a selection, the group alert configuration will be displayed in the GroupAlertDefinition 
table below. See screen shot below:  
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Figure 4.2.2.4.1-6.  View Business Process Group Alert 

Operator can delete the selected group alert by clicking on the "Delete Selected GroupAlert" 
button. 

Operator can modify the group alert definition by selecting a different status definition of the 
business process on the status drop down list next to the Group Alert name on the top of the 
page; or/and check/uncheck the checkboxes in the GroupAlertDefinition table, then click the 
"Update Selected GroupAlert" button to update the group alert definition. See screen shot 
below:  
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Figure 4.2.2.4.1-7.  Update Business Process Group Alert 

Operator can add a new group alert by clicking on the "Add GroupAlert" button. See screen shot 
below: 

 

Figure 4.2.2.4.1-8.  Add new Business Process Group Alert 
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Operator can type in the group alert name in the GroupName text box, select the status definition 
of the group alert via the StatusDefinition drop down list and check/uncheck the checkboxes in 
the GroupAlertDefinition table to add selected individual resource alerts in the group alert 
definition. Operator can cancel the add operation by clicking the "Cancel" button. Once operator 
click the "Save" button and confirm through the confirmation popup window. A new group alert 
will be added and become visible through the Group Alerts drop down list on the group alert 
configuration page. See screen shot below: 

 

Figure 4.2.2.4.1-9.  View added Business Process Group Alert 

4.2.2.4.1.3 View Business Process 

With the custom HQU plugin, an operator can use the Hyperic GUI to get a quick overview of 
the status of all business processes. The business process page can be navigated to via the 
Resource tab and clicking on the 'Business Processes' link. 

 

Figure 4.2.2.4.1-10.  Business Processes Link 
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Business Process Status Page 

The Business Process Status page is divided into two panes. The left pane contains a list of 
business processes. It shows the name and the business process status. The business process that 
is currently selected is highlighted in blue.  The right pane contains a list of resources for the 
selected business process. It shows the resource name, the status of the resource, and the reason 
explaining why a resource is not available.  Clicking on the resource name will take the operator 
to a detailed page of the resource. Selecting another business process will update the resource list 
in the right pane.  

 

Figure 4.2.2.4.1-11.  View Business Process Page - DPL Ingest Archive 



 4.2.2-109 609-EED-001, Rev. 03 

 

Figure 4.2.2.4.1-12.  View Business Process - DPL Ingest Down 

Mode Tabs 

The Mode Tabs renders a different view of the Business Process filtered by mode. All business 
processes are defined within a specified mode thus the specified mode tab will display only those 
business process defined within the current mode 

 

Figure 4.2.2.4.1-13.  Business Process Mode Tab 

Business Process Status Table 

The Business Process Status Table provides a quick view of the overall health of a business 
process. The "Business Processes" column provides the name of all the business processes within 
the specified mode. The "Status" column provides the overall status of the business process. The 
status of the business process is determined by the alerts that correspond to the resources that are 
members of the business process. An xml configuration file will hold the definitions of the 
impact an alert has on the overall state of a business process (For more details see section 
4.2.2.4.2.2 Configure Business Process). The Business Process Status Table controls the 
Business Process Resource Table located to the left of it. When the cursor is placed over the 
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name of a particular business process within the Business Process Status Table it is highlighted 
and the Business Process Resource Table will refresh to display information on the resources that 
are members of the selected business process. 

 

Figure 4.2.2.4.1-14.  Business Process Status Table 

Business Process Resource Table 

The Business Process Resource Table provides a view of the resources that are members of the 
current business process selected in the Business Process Status Table. Besides the resources 
defined in the hyperic system, custom group alerts are also displayed as a type of resource. This 
gives user a better view when the business process status is determined by a custom group alert. 

The "Name" column contains the name of a resource. The resource name can be clicked on for a 
detailed view of the resource. The "Priority" column defines the status of a resource. If any alerts 
have fired that pertain to a resource, the column will display the status change. The "Alert 
Definition" column will display the names of any alerts related to the resource that have fired 
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and have not been fixed. The alert name can be clicked on for a detailed view of the alert 
definition. 

 

Figure 4.2.2.4.1-15.  Business Process Resource Table 

Business Process Status Definition 

The Business Process Status Definition legend defines the meaning of each icon displayed in the 
Business Process Status Table. 

 Active – There is work to do and the work is being completed as expected 

 Inactive – All of the components appear to be functional, but there is no work to 
complete 

 Degraded – The service is functioning but not at the required capacity 

 Down – The service is unable to complete any work 
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Figure 4.2.2.4.1-16.  Business Process Status Definition 

Resource Status 

The Resource Status legend defines the meaning of each icon displayed in the Business Process 
Resource Table. 

 Available – The resource is currently up 

 Unavailable – The resource is currently down 

 Alert Pending – There is at least one alert pending for the resource 

 

Figure 4.2.2.4.1-17.  Business Process Resource Status 

4.2.2.4.2 DPL Ingest Business Process 

This section describes the resources that are grouped within the DPL Ingest Business Process. 

4.2.2.4.2.1 Ingest Resources 

Hosts 

 x4dpl01 / x5dpl01 

 ECS Service Hosts 

Custom Code Servers 

 Polling 

 Processing 

 Notification 

 QuickServer 

File Systems 

 Data Pool 

 Archive 
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Database 

 PostgreSQL 

Apache / Tomcat Web Server 

StorNext Primary Metadata Server 

4.2.2.4.2.2 DPL Ingest Host 

A Hyperic agent will be installed on each host used by DPL Ingest.  Each host will be configured 
to be monitored via Hyperic's auto-discovery service.  Once the host is selected to be monitored 
there are a number of metrics that can be captured including availability, load average, CPU 
usage, TCP statistics, memory usage, and swap space. 

 

Figure 4.2.2.4.2-1. DPL Ingest Host Monitor Page 

4.2.2.4.2.3 Polling Server 

The Ingest Polling Server monitoring is done through a custom xml plug-in. There is one plug-in 
file per mode. The plug-in file name is <MODE>-DPL-InPollingService-plugin.xml. 
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Since almost all the custom xml plug-ins are organized as one per mode, only one template of 
each plug-in will be saved in the Clearcase and delivered. Upon installation in the DAACs, the 
plugin generator script will read in the plugin template and generate the mode specific plug-ins 
for the specified mode. This installation detail will be omitted in the subsequent server 
descriptions. See the attached appendix for the Polling Server xml plug-in file for OPS mode. 

The metrics that will be collected for the Ingest Polling Server include the standard Hyperic 
metrics (see section 4.2.2.2.13: Standard Plugin Metrics) and custom metrics (see below). 

Table 4.2.2.4.2-1.  Polling Server Metrics 
Custom Metrics 

Metric Name Description 

NumOpenAlerts The total number of open alerts in the Polling server. 

The Polling server resource will be auto-discovered by Hyperic using the PTQL query defined in 
the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the custom 
metrics will be collected through the SQL plug-in by querying the Ingest database. 

If the Polling Server is up after the custom xml plug-in is deployed in Hyperic, the Polling Server 
will be auto-discovered by Hyperic and shows up in the Auto-Discovery list. The user can then 
choose the Polling Server from the Auto-Discovery list to add it to the inventory (refer to the 
Auto-discovery section of the document for details). 

Up/down alerts are set up for the Polling server based on its availability metrics. The down alert 
is used to notify a user of the problem, update the DPL Ingest business process status, and trigger 
the control action that will automatically start the server; the up alert is used as a recovery alert 
for the down alert to mark the down alert as fixed. 

Below are some details on the control actions and alerts configurations: 

To configure the control action for starting the server, go to the Inventory page of the Polling 
Server. See screen shot below:  
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Figure 4.2.2.4.2-2.  Polling Server Inventory Page 

Note if the server.config_track.files configuration is blank and the server.config_track.enable is 
false on this page even though the configuration file is specified in the server plugin xml and 
configuration tracking is turned on by default. This is due to a Hyperic bug (HHQ-3627 
DaemonDetector does not set control configuration) in Hyperic. To work around the bug, 
operator has to manually accept the Configuration Properties setting again by performing the 
following two steps: 

Click on the "EDIT" button on the Configuration Properties section to bring up the Configuration 
Properties detail page. On this page, operator can see the configuration file name is already 
populated and the server.config_track.enable checkbox is checked. Operator can also verify the 
Program under the Control section is set to the correct value. In this specific example, it is set to: 
/usr/ecs/OPS/CUSTOM/utilities/EcMsSmBaseControl which is specified in the 
"DEFAULT_PROGRAM" element in the xml plug-in file. See screen shot below: 

NOTE: The EcMsSmBaseControl is a custom script used to execute a Linux command or script 
as the cmshared user. This script is generally used for starting, stopping, and restarting ECS 
resources as a control action in an alert but can be used to perform other tasks. 
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Figure 4.2.2.4.2-3.  Polling Server Configuration Properties Page 

Click "Ok" button to accept the configuration.  This is the manual step to register the 
configuration with the hyperic server to work around the bug mentioned above. After operator 
clicked "Ok" to manually accept the configuration, the server.config_track.files and the 
server.config_track.enable configuration properties are shown with the correct values. See screen 
shot below:  
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Figure 4.2.2.4.2-4.  Polling Server Inventory Page after Manual Update 

To configure the server down/up alerts, go to the alert page of the Polling Server. See screen shot 
below: 

 

Figure 4.2.2.4.2-5.  Polling Server Configure Alert Definition 

Click on the "Configure" button on the page to set up the alerts (refer to section 4.2.2.2.6, Alert 
and Control Action for more details). First we will set up the server down alert. The server down 
alert is based on the condition of Availability metric. See screen shot below for more details: 
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Figure 4.2.2.4.2-6.  Polling Server New Alert Definition 

Click the "Ok" button will bring us to the alert definition page, see below: 

 

Figure 4.2.2.4.2-7.  Polling Server Alert Definition Page 

Next, click on the "Control Action" tab and then "Edit" to link the previous configured server 
start control action to the down alert. See the next two screen shots: 
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Figure 4.2.2.4.2-8.  Polling Server Select Control Action 

 

Figure 4.2.2.4.2-9.  Polling Server Configure Control Action 

Choose the "EcDlInPollingServiceStart" (this is configured through the "actions include" 
element in the xml plug-in file) as the Control Type and click "OK". Operator can click on the 
"Notify Roles", "Notify HQ Users" or "Notify Other Recipients" tabs to configure the 
notification mechanism when the alert fires. This completes the Polling Server down alert 
configuration. 

Go back to the alert page of the Polling Server, click on the "New" button to configure the server 
up alert. On the Alert Definition page, set the Recovery Alert drop down list to the down alert. 
This will mark the previous server down alert as "fixed" when the server up alert fires. See 
screen shot below: 
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Figure 4.2.2.4.2-10.  Polling Server Set Recovery Alert 

Click on "Ok" button to accept the change and this completes the server up alert configuration. 
There is no need to link any control action to the server up alert since it is configured to be a 
recovery action. 

After all the above configurations are complete, the Polling Server will be monitored by Hyperic 
and when the EcDlInPollingService custom server goes down, a PollingService_OPS down alert 
will be generated and the configured operators will be notified through their configured 
notification methods. The control action will be called to automatically start the 
EcDlInPollingService custom server. Once the server is back up, a server up alert will be 
generated and it will mark the server down alert as fixed, then the server up alert will be 
automatically closed. 

4.2.2.4.2.4 Processing Server 

The Ingest Processing Server monitoring is done through an xml custom plug-in. There is one 
plug-in file per mode. The plug-in file name is <MODE>-DPL-InProcessingService-plugin.xml. 
See attached appendix for the Processing Server xml plug-in file of OPS mode. 

The metrics that will be collected for the Ingest Processing Server include the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics) and custom metrics (see below). 
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Table 4.2.2.4.2-2.  Processing Server Metrics 
Custom Metrics 

Metric Name Description 

RequestQueueSize The total number of requests queued in the system. 

GranuleQueueSize The total number of granules queued in the system. 

ScienceGranuleQueueSize The total number of science granules queued in the system. 

NumOpenAlerts The total number of open alerts in the processing server. 

NumOpenInterventions The total number of open interventions in the processing server. 

NumOldRequests 
The total number of requests older than a user defined number of 
hours. 

NumOldGranules 
The total number of granules older than a user defined number of 
hours. 

Throughput (gran/min) 
The average number of granules throughput per minute over the 
last five minutes. 

ScienceGranuleThroughput 
(gran/min) 

The average number of science granules throughput per minute 
over the last five minutes. 

Throughput (MB/min) 
The average volume (in MB) throughput per minute over the last 
five minutes. 

CompletionTime (minutes) 
The estimated time (in minutes) to complete the work currently 
queued in the system. 

The Processing server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the 
custom metrics will be collected through the SQL plug-in by querying the Ingest database. 

Up/down alerts are set up for the Processing server based on its availability metrics. The down 
alert is used to notify operator of the problem and update the DPL Ingest business process status 
and trigger the control action that will automatically start the server; the up alert is used as a 
recovery alert for the down alert to mark the down alert as fixed. 

Please refer to screen shots in 4.3 Polling Server for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.2.5 Notification Server 

The Ingest Notification Server monitoring is done through an xml custom plug-in. There is one 
plug-in file per mode. The plug-in file name is <MODE>-DPL-InNotificationService-
plugin.xml. See the attached appendix for the Notification Server xml plug-in file of OPS mode. 

The metrics that will be collected for the Ingest Notification Server include the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics) and custom metrics (see below). 
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Table 4.2.2.4.2-3.  Notification Server Metrics 
Custom Metrics 

Metric Name Description 

NotificationQueueSize 
The total number of notifications queued in the system with 
notification status of "READY". 

NumOpenAlerts The total number of open alerts in the notification server. 

The Notification server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the 
custom metrics will be collected through the SQL plug-in by querying the Ingest database. 

Up/down alerts are set up for the Notification server based on its availability metrics. The down 
alert is used to notify operator of the problem and update the DPL Ingest business process status 
and trigger the control action that will automatically start the server; the up alert is used as a 
recovery alert for the down alert to mark the down alert as fixed. 

Please refer to screen shots in 7.3 Polling Server for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.2.6 QuickServer 

QuickServer monitoring is done through an xml custom plug-in. There is one plug-in file per 
mode. The file name is <MODE>-DPL-QuickServer-plugin.xml. See the attached appendix for 
the Quick Server xml plug-in file of OPS mode. 

The metrics that will be collected for the Quick Server include the standard Hyperic metrics (see 
section 4.2.2.2.13, Standard Plugin Metrics). 

The QuickServer resource will be auto-discovered by Hyperic using the PTQL query defined in 
the xml plug-in. The standard metrics will be collected by the SIGAR plug-in. 

Up/down alerts are set up for the QuickServer based on its availability metrics. The down alert is 
used to notify operator of the problem and update the DPL Ingest business process status and 
trigger the control action that will automatically start the server; the up alert is used as a recovery 
alert for the down alert to mark the down alert as fixed. 

Please refer to screen shots in 7.3 Polling Server for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.2.7 Data Providers 

Data provider monitoring is done using the built-in Hyperic group and service metrics 
monitoring capability through a custom xml plug-in. See the attached appendix for the data 
provider xml plug-in file of OPS mode. 

We collect the following metrics for each data provider: 
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Table 4.2.2.4.2-4.  Data Provider Metrics 
Custom Metrics 

Metric Name Description 

RequestQueueSize The total number of requests queued for the provider. 

GranuleQueueSize The total number of granules queued for the provider. 

ScienceGranuleQueueSize The total number of science granules queued for the provider. 

NumOpenAlerts The total number of open alerts for the provider. 

NumOpenInterventions The total number of open interventions for the provider. 

Throughput (gran/min) 
The average number of granules throughput per minute over the 
last five minutes for the provider. 

ScienceGranuleThroughput 
(gran/min) 

The average number of science granules throughput per minute 
over the last five minutes for the provider. 

Throughput (MB/min) 
The average volume (in MB) throughput per minute over the last 
five minutes for the provider. 

CompletionTime (minutes) 
The estimated time (in minutes) to complete the work currently 
queued for the provider. 

All data providers in a mode are displayed as a group called "<MODE>_PROVIDERS". The 
<MODE>_PROVIDERS group can be added to the "Favorite Resources" portlet on the 
Dashboard for easy access. See screen shot below: 
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Figure 4.2.2.4.2-11.  Data Provider Dashboard 

Click on the OPS_PROVIDERS will bring up the providers details page which lists the list of 
defined data providers in the OPS mode and the combined statistic metrics of all the providers. 
See screen shot below: 
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Figure 4.2.2.4.2-12.  Data Provider Group Monitor Page 

To see the metrics of an individual provider, click on the provider name in the "Resources" 
window on the left. See below for a screen shot of the provider detail page. 
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Figure 4.2.2.4.2-13. Individual Data Provider Monitor Page 

Below are the four major steps to set up the OPS_PROVIDERS for monitoring: 

1. Define the data provider resource through a custom plugin. The data provider resource is 
defined as a platform service type on the DPL box. The plugin xml is named 
<MODE>_dataprovider-plugin.xml. It defines the metrics that pertain to the resource 
type of dataprovider. Please refer to the general instruction on how to deploy a plugin in 
Hyperic. 

2. Define the OPS_PROVIDERS compatible (not mixed) group. The group type should be 
dataprovider_OPS. Please refer to the general instruction on how to define a compatible 
group in Hyperic. 

3. Configure individual data provider through Hyperic GUI. See section below for details. 

Add the configured individual data provider to the OPS_PROVIDERS group. Please refer to the 
general instruction on how to add a resource to a group. 

Below is a detailed description on how to configure an individual data provider using the 
Hyperic GUI. 
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Click on the "Resource" tab at the top of the page. Select "Browse" in the drop-down menu. 
Click on "Platforms" tab to list all the platforms defined in the system. Click on the platform 
where DPL Ingest servers are installed (i.e. x4dpl01 / x5dpl01 box) to bring up the platform 
detail page. See the screen shot below for an example: 

 

Figure 4.2.2.4.2-14.  Host Resource Page 

On the platform detail page, click on the "Tools Menu" drop down that is located on the upper 
left corner of the page, then click on "New Platform Service" in the drop down menu. See Screen 
shot below: 
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Figure 4.2.2.4.2-15.  Add New Platform Service 

This brings up the new platform service configuration page. On this page, fill in the name of the 
data provider and description, on the Service Type drop down menu, select "dataprovider_OPS". 
See screen shot below: 
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Figure 4.2.2.4.2-16.  Configure Individual Data Provider 

Then click "OK". The service detail page will pop up as a result. See below: 

 

Figure 4.2.2.4.2-17.  Individual Data Provider Inventory Page 

Click on the link to configure its configuration properties. On the popped up page, the script 
input text box should be prepopulated and does not need to be modified. In the providerName 
input text box, type in the name of the data provider. 

Note: the provider name typed in has to exactly match the ExternalDataProvider field 
defined in the InExternalDataProvider table in Ingest database. See the screen shot below:  
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Figure 4.2.2.4.2-18.  Individual Data Provider Configuration Page 

Click on "OK" to accept the configuration. The screen will go back to the service detail 
page.  That is the end of configuring an individual data provider. 

Once the data provider is configured, the Hyperic server will be able to collect the defined 
metrics by executing the script (defined in the plugin xml file) periodically which invokes a Perl 
script to retrieve the requested statistic information from the Ingest database. The Perl script 
invokes a stored proc named SmGetProviderMetrics.sp which takes the data provider name as 
input and outputs the metrics information for that data provider. 

4.2.2.4.2.8 DPL Ingest services 

DPL Ingest services monitoring is done using the built-in Hyperic group and service metrics 
monitoring capability through a custom xml plug-in. See the attached appendix for the DPL 
Ingest services xml plug-in file of OPS mode. 

We collect the following metrics for DPL Ingest services: 

 isDpiuActive 

 isXvuActive 

 isIiuActive 

 numTransferServiceAvailable 

 numTransferServiceSuspended 

 numChecksumServiceAvailable 

 numChecksumServiceSuspenced 

 numArchiveServiceAvailable 

 numArchiveServiceSuspended 

The DPL Ingest services plug-in is defined as a service within hyperic. Operator can add it to the 
x4dpl01 / x5dpl01 platform to start collecting the metrics. This is done by clicking the "New 
Platform Service" menu under the "Tools Menu" of the platform detail page. See screen shot 
below: 
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Figure 4.2.2.4.2-19.  Add a New Platform Service 

On the new platform service configuration page, select the Ingest services for the mode and type 
in the name and description, then click "OK" to create the platform service. See screen shot 
below: 
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Figure 4.2.2.4.2-20.  Create Ingest Services Monitor Service 

Wait for a few minutes, the metrics info will show up on the Ingest services monitor page. See 
screen shot below: 
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Figure 4.2.2.4.2-21.  Ingest Services Metrics 

Then click on the Alert tab to configure the alerts and recovery alerts that are necessary for the 
DPL Ingest business process monitoring. See below for a list of alert definitions that should be 
configured for the Ingest services monitoring: 
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Figure 4.2.2.4.2-22.  Ingest Services Alert Definitions 

4.2.2.4.2.9 DataPool File System 

Data Pool file systems and Archive file systems will be discovered automatically via Hyperic 
when any host that mounts that file system is configured to be monitored.  File systems are 
displayed as services within the 'FileServer Mount' section for a platform.  Metrics that can be 
captured include availability and free space.  I/O statistics can be captured for some file systems; 
however, currently I/O statistics cannot be captured for StorNext file systems. 
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Figure 4.2.2.4.2-23.  DataPool File System Monitor Page 

4.2.2.4.2.10 Archive File System 

See section 4.2.2.4.2.10, Data Pool File System. 

4.2.2.4.2.11 Apache / Tomcat Web Server 

See section 4.2.2.3.2, Configuring Tomcat. 

4.2.2.4.2.12 StorNext Primary Metadata Server 

See section 4.2.2.3.8, Configuring StorNext Host Monitoring. 

4.2.2.4.2.13 Monitor number of active sessions of Tomcat Web applications 

We modified hyperic tomcat plug-in jar file to provide the functionality to be able to monitor the 
number of active sessions of a particular Apache Tomcat web application. It is done through a 
hyperic service type named "Apache Tomcat 6.0 WebApp Session Count". One service of 
"Apache Tomcat 6.0 WebApp Session Count" service type will be created automatically for each 
deployed tomcat web service after tomcat is auto-discovered by hyperic server. Operator can list 
all the WebApp Session Count services by filtering on the service type. See screenshot below:  
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Figure 4.2.2.4.2-24.  List of WebApp Session Count Services 

The number of active sessions of a web service is monitored through the metric named 
activeSessions. By default, the collection of the activeSessions is turned off. Operator should 
turn on the metrics collection of the WebApp Session Count service for the particular web 
application service he/she wants to monitor. For example, if operator wants to monitor the 
number of active sessions of WebAccess service in OPS mode, he/she can click on the WebApp 
Session Count service of the WebAccess service link and turn on the metrics collection of 
activeSessions. The following is a way of doing this: 

To identify the WebApp Session Count service for DataAccess service in OPS mode, operator 
can filter by the name of WebAccess service on the service listing page. See screen shot below: 
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Figure 4.2.2.4.2-25.  Identify WebApp Session Count Service for OPS WebAccess 
Service 

Click on the link of the WebAccess service to enter the monitor page of the service, see screen 
shot below:  
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Figure 4.2.2.4.2-26.  WebApp Session Count Service of OPS WebAccess 

Click on the "METRIC DATA" tab to navigate to the metrics page, then click on the "Show All 
Metrics" arrow if activeSessions metrics is not listed on the page already. Once the 
activeSessions metrics is listed on the page, operator can modify the Collection Interval of the 
activeSessions metrics from NONE to a desired value (e.g. 5 minutes) to start the metrics 
collection of the activeSessions metrics. See screen shot below: 
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Figure 4.2.2.4.2-27.  activeSessions Metrics Collections 

4.2.2.4.3 Data Access Business Process 

This section describes the resources that are grouped within the DPL Ingest Business Process. 

4.2.2.4.3.1 Data Access Resources 

Hosts 

 x5eil01 

Custom Code 

 Web Order Status GUI 

File Systems 

 Data Pool 

Database 

 PostgreSQL 

Apache / Tomcat Web ServerWu-FTP Server 

4.2.2.4.3.2 x5eil01 Host 

A Hyperic agent will be installed on the x5eil01 host.  The host will be configured to be 
monitored via Hyperic's auto-discovery service.  Once the host is selected to be monitored there 
are a number of metrics that can be captured including availability, load average, CPU usage, 
TCP statistics, memory usage, and swap space. 
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Figure 4.2.2.4.3-1.  x5eil01 Host Monitor Page 

4.2.2.4.3.3 Web Order Status GUI 

The URL to the Web Order Status GUI is http://<hostname>:<port>/OrderStatus <_MODE>, an 
example is http://f4eil01.edn.ecs.nasa.gov:22500/OrderStatus. To monitor the website, Hyperic 
provides a HTTP service that can be configured to periodically submit an http request to a 
specified URL. Hyperic will read the responses and determine if the website is available or not. 
Below are the steps to configure Hyperic to monitor the Web Order Status GUI. 

1. Select a platform where you want to define your HTTP service. The agent on this 
platform will be in charge of submitting a http request and reading the responses. Mouse 
over the 'Resources' tab and select the 'Browse' option. Click on the 'Platforms' link if it 
isn't highlighted and select a platform. 
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Figure 4.2.2.4.3-2. Select Web Order Status GUI HTTP Service Platform  

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 

 

Figure 4.2.2.4.3-3. Web Order Status GUI Add New Service 
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3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: OrderStatus GUI OPS 
Description: This service monitors the OrderStatus GUI in the OPS mode. 
Service Type: HTTP 

 

Figure 4.2.2.4.3-4. Web Order Status GUI General Properties 

4. You will be taken to the service detail page, but the service has not been configured to 
monitor the Web Order Status GUI yet. Click on the 'Configuration Properties' link. 
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Figure 4.2.2.4.3-5. Web Order Status GUI Configuration Properties Link 

5. In the configuration properties page fill in the following fields (below is an example from 
EDF) and click the 'OK' button. 

hostname: f4eil01.edn.ecs.nasa.gov 
port: 22500 
*sotimeout: 60 
path: /OrderStatus  

method: GET 
follow: check the box 
**proxy: <hostname>:<port> 

*This is the amount of time in seconds Hyperic will timeout from the http request. 

**If your internal network uses a proxy to get out supply it here.  
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Figure 4.2.2.4.3-6.  Web Order Status GUI Configuration Properties Page 

6. The Web Order Status GUI HTTP service is now configured and you can go ahead and 
monitor it, setup alerts, and change the monitoring interval of the metrics it gathers. 

 

Figure 4.2.2.4.3-7.  Web Order Status GUI Monitoring 
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4.2.2.4.3.4 DataPool File System 

See section 4.2.2.4.2.9, DataPool File System. 

4.2.2.4.3.5 PostgreSQL 

See section 4.2.2.3.1, Configuring PostgreSQL. 

4.2.2.4.3.6 Apache / Tomcat Web Server 

See section 4.2.2.3.2, Configuring Tomcat. 

4.2.2.4.3.7 Wu-FTP Server 

The Wu-FTP COTS Server runs on the x5eil01 host servicing ftp requests. A custom server, 
FtpDataCollector was developed to poll the Wu-FTP log for completed request and the 
information captured is stored in the Postgres database.  In order to monitor the Wu-FTP Server 
a FTP service is configured to periodically ping the server to determine if it is availability, its 
response time, and to gather ftp protocol specific metrics. A custom Hyperic plugin was 
developed to monitor the FtpDataCollector server and to retrieve the information stored in the 
Postgres database for display in the Hyperic GUI. 

4.2.2.4.3.7.1 Configure FTP Service 

Please refer to the "Configure FTP" section. The section provides step-by-step instructions on 
how to configure an ftp service to monitor a host with an ftp server running. 

4.2.2.4.3.7.2 FtpDataCollector Server 

The EcMsSmFtpDataCollector Server monitoring is done through an xml custom plug-in. There 
is one plug-in file per host. The plug-in file name is FtpDataCollector-plugin.xml. 

The metrics that will be collected for the FtpDataCollector Server includes the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics) and custom metrics (see below). 

Table 4.2.2.4.3-1.  FtpDataCollector Metrics 
Custom Metrics 

Metric Name Description 

Number of Ftp Sessions The total number of ftp sessions for the host. 

Number of Ftp Transfers 
The total number of ftp transfers over the last five minutes for 
the host. 

Ftp Transfer Rate 
The average ftp volume (in MB) throughput per minute over 
the last five minutes for the host. 

Number of Http Transfers 
The total number of http transfers over the last five minutes for 
the host. 

Http Transfer Rate 
The average http volume (in MB) throughput per minute over 
the last five minutes for the host. 
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The FtpDataCollector Server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the 
custom metrics will be collected through the SQL plug-in by querying the Ingest database. 

Up/down alerts are set up for the FtpDataCollector Server based on its availability metrics. The 
down alert is used to notify operator of the problem and update the Data Access business process 
status and trigger the control action that will automatically start the server; the up alert is used as 
a recovery alert for the down alert to mark the down alert as fixed. 

Please refer to screen shots in 7.3 Polling Server for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.4 Order Management Business Process 

This section describes the resources that are grouped within the Order Manager Business 
Process. 

4.2.2.4.4.1 Order Management Resources 

Hosts 

 x5oml01 

Custom Code 

 Order Manager Server 

 EPD Server 

 Copy Server 

 EWOC 

 ECHO REVERB  

File Systems 

 Data Pool 

Database 

 PostgreSQL 

HSA 

4.2.2.4.4.2 Order Manager Host 

A Hyperic agent will be installed on each host used by Order Manager.  Each host will be 
configured to be monitored via Hyperic's auto-discovery service.  Once the host is selected to be 
monitored there are a number of metrics that can be captured including availability, load average, 
CPU usage, TCP statistics, memory usage, and swap space. 
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Figure 4.2.2.4.4-1.  Order Manager Host Monitor Page 

4.2.2.4.4.3 Order Manager Server 

The Order Manager Server monitoring is done through an xml custom plug-in. There is one 
plug-in file per mode. The plug-in file name is <MODE>-OMS-OrderManager-plugin.xml. 

The metrics that will be collected for the Order Manager Server include the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics) and custom metrics (see below). 

Table 4.2.2.4.4-1.  Order Manager Server Metrics (1 of 2) 
Custom Metrics 

Metric Name Description 

RequestQueueSize The total number of requests queued in the system. 

GranuleQueueSize The total number of granules queued in the system. 
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Table 4.2.2.4.4-1.  Order Manager Server Metrics (2 of 2) 
Custom Metrics 

Metric Name Description 

NumOpenAlerts The total number of open alerts in the server. 

NumOpenInterventions The total number of open interventions in the server. 

NumSuspendedDestinations The total number of suspended destinations in the server 

Throughput (gran/min) 
The average number of granules throughput per minute over the 
last five minutes. 

Throughput (MB/min) 
The average volume (in MB) throughput per minute over the last 
five minutes. 

FtpPushThroughput (gran/min) 
The average number of granules throughput per minute over the 
last five minutes for ftp push orders. 

FtpPushThroughput (MB/min) 
The average volume (in MB) throughput per minute over the last 
five minutes for ftp push orders. 

FtpPullThroughput (gran/min) 
The average number of granules throughput per minute over the 
last five minutes for ftp pull orders. 

FtpPullThroughput (MB/min) 
The average volume (in MB) throughput per minute over the last 
five minutes for ftp pull orders. 

The Order Manager server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the 
custom metrics will be collected through the SQL plug-in by querying the OMS database. 

Up/down alerts are set up for the Order Manager server based on its availability metrics. The 
down alert is used to notify operator of the problem and update the Order Manager business 
process status and trigger the control action that will automatically start the server; the up alert is 
used as a recovery alert for the down alert to mark the down alert as fixed. 

Please refer to screen shots in 7.3 Polling Server for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.4.4 OM Destination 

Om Destination monitoring is done using the built-in Hyperic group and service metrics 
monitoring capability through a custom xml plug-in. 

We collect the following metrics for each destination: 

 Throughput (granules/minutes over the previous five minutes) 

 Throughput (MB/minutes over the previous five minutes) 

All destinations in a mode are displayed as a group called "<MODE>_DESTINATIONS". The 
<MODE>_DESTINATIONS group can be added to the "Favorite Resources" portlet on the 
Dashboard for easy access. See screen shot below:  
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Figure 4.2.2.4.4-2.  Destination Dashboard 

Click on the OPS_DESTINATIONS will bring up the providers details page which lists the list 
of defined destinations in the OPS mode and the combined statistic metrics of all the 
destinations. See screen shot below: 
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Figure 4.2.2.4.4-3.  Data Provider Group Monitor Page 

To see the metrics of an individual destination, click on the destination name in the "Resources" 
window on the left. See below for a screen shot of the destination detail page. 

Below are the four major steps to set up the OM Destination for monitoring: 

1. Define the destination resource through a custom plugin. The destination resource is 
defined as a platform service type on the OML box. The plugin xml is named 
<MODE>-OMS-Destination -plugin.xml. It defines the metrics that pertain to the 
resource type of destination. Please refer to the general instruction on how to deploy a 
plugin in Hyperic. 

2. Define the OPS_DESTINATIONS compatible (not mixed) group. The group type 
should be destination_OPS. Please refer to the general instruction on how to define a 
compatible group in Hyperic. 

3. Configure individual destinations through Hyperic GUI. See section below for details. 

4. Add the configured individual destination to the OPS_DESTINATIONS group. 
Please refer to the general instruction on how to add a resource to a group. 
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Below is a detailed description on how to configure an individual destination using the Hyperic 
GUI. 

Click on the "Resource" tab at the top of the page. Select "Browse" in the drop-down menu. 
Click on "Platforms" tab to list all the platforms defined in the system. Click on the platform 
where OMS servers are installed (i.e. x5oml01 box) to bring up the platform detail page. See the 
screen shot below for an example:  

 

Figure 4.2.2.4.4-5.  Host Resource Page 

On the platform detail page, click on the "Tools Menu" drop down that is located on the upper 
left corner of the page, then click on "New Platform Service" in the drop down menu. See Screen 
shot below: 
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Figure 4.2.2.4.4-6.  Add New Platform Service 

This brings up the new platform service configuration page. On this page, fill in the name of the 
destination and description, on the Service Type drop down menu, select "Destination_OPS". 
See screen shot below: 
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Figure 4.2.2.4.4-7.  Configure Individual Destination 

Then click "OK". The service detail page will pop up as a result. See below:  

 

Figure 4.2.2.4.4-8.  Individual Destination Inventory Page 

Click on the link to configure its configuration properties. On the popped up page, the script 
input text box should be prepopulated and does not need to be modified. In the destinationName 
input text box, type in the name of the destination. Note: the destination name typed in has to 
exactly match the DestinationName field defined in the OmConfigDestination table in OMS 
database. See the screen shot below:  
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Figure 4.2.2.4.4-9.  Individual Destination Configuration Page 

Click on "OK" to accept the configuration. The screen will go back to the service detail 
page.  That is the end of configuring an individual destination. 

Once the destination is configured, the Hyperic server will be able to collect the defined metrics 
by executing the script (defined in the plugin xml file) periodically which invokes a Perl script to 
retrieve the requested statistic information from the Ingest database. The Perl script invokes a 
stored proc named SmGetDestinationMetrics.sp which takes the destination name as input and 
outputs the metrics information for that destination. 

4.2.2.4.4.5 EPD Server 

The EPD Server monitoring is done through an xml custom plug-in. There is one plug-in file per 
mode. The plug-in file name is <MODE>-OMS-EPDServer-plugin.xml. The EPD Server 
resource will be auto-discovered by Hyperic using the PTQL query defined in the xml plug-in. 
The standard metrics will be collected by the SIGAR plug-in. 

Up/down alerts are set up for the EPD Server based on its availability metrics. The down alert is 
used to notify operator of the problem and update the Order Management business process status 
and trigger the control action that will automatically start the server; the up alert is used as a 
recovery alert for the down alert to mark the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 
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Figure 4.2.2.4.4-10.  EPDServer Configuration View 
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Figure 4.2.2.4.4-11.  EPDServer Monitoring 

4.2.2.4.4.6 Copy Server 

The Order Manager Copy Server monitoring is done through an xml custom plug-in. There is 
one plug-in file per mode. The plug-in file name is <MODE>-OMS-CopyServer-plugin.xml. The 
plugin defines the server type and an operator will need to configure Hyperic to monitor the 
Copy Server. Below are the steps to configure Hyperic to monitor this resource. 

1. Select the platform where the Copy Server runs on. The agent on this platform will be 
in charge of gathering metrics for this resource. Mouse over the 'Resources' tab and 
select the 'Browse' option. Click on the 'Platforms' link if it isn't highlighted and select 
a platform. 
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Figure 4.2.2.4.4-12.  Copy Server Select Platform 

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'New 
Server' option. 
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Figure 4.2.2.4.4-13.  Copy Server Add New Server 

3. A new server general properties page will be displayed. Fill in the name, description, 
server type, and install path. Afterward, click the 'OK' button. 

Name: OmCopyServer_OPS 
Description: This service monitors the OmCopyServer in the OPS mode. 
Server Type: OmCopyServer_OPS 
Install Path: /usr/ecs/OPS/CUSTOM/bin/OMS/EcOmSrCopyServer.pl  
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Figure 4.2.2.4.4-14.  Copy Server General Properties 

4. You will be taken to the server detail page, but the server has not been configured to 
monitor the Copy Server yet. Click on the 'Configuration Properties' link. 

 

Figure 4.2.2.4.4-15.  Copy Server Configuration Properties Link 

5. In the configuration properties page, leave all the properties as it is and verify that the 
control program is pointing to /tools/common/hyperic/utilities/<MODE>-
EcMsSmBaseControl (where MODE is fill in) and click the 'OK' button. 
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Figure 4.2.2.4.4-16.  Copy Server Configuration Properties 

6. The Copy Server is now configured and you can go ahead and monitor it, setup alerts, 
and change the monitoring interval of the metrics it gathers. 
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Figure 4.2.2.4.4-17.  Copy Server Monitoring 

The metrics that will be collected for the Copy Server include the standard Hyperic metrics (see 
section 4.2.2.2.13: Standard Plugin Metrics) and custom metrics (see below).  

Table 4.2.2.4.4-2.  Copy Server Metrics 
Custom Metrics 

Metric Name Description 

Number of Processes The number of Copy Server instances running. 

Up/down alerts are set up for the Copy Server based on its availability metrics. The down alert is 
used to notify operator of the problem and update the Order Management business process status 
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and trigger the control action that will automatically start the server; the up alert is used as a 
recovery alert for the down alert to mark the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.4.4.7 EWOC 

The URL to the EWOC Apache Axis homepage is http://<hostname>:<port number>/EWOC/. 
EWOC provides two services, OrderStatusUpdate and OrderFullfillment. The example below 
will show you how to configure HTTP services via Hyperic to monitor the EWOC 
OrderStatusUpdatePort and OrderFullfillmentPort wsdl. 

Note: WSDL is an xml-based language which describes a web service. 

1. Select a platform where you want to define your HTTP service. The agent on this 
platform will be in charge of submitting an http request and reading the responses. 
Mouse over the 'Resources' tab and select the 'Browse' option. Click on the 'Platforms' 
link if it isn't highlighted and select a platform. 

 

Figure 4.2.2.4.4-18.  Select EWOC HTTP Service Platform 

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 
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Figure 4.2.2.4.4-19.  EWOC Add New Service 

3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: Monitor EWOC_OrderStatusUpdatePort_OPS 
Description: This service monitors EWOC OrderStatusUpdatePort wsdl. 
Service Type: HTTP 
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Figure 4.2.2.4.4-20.  EWOC OrderStatusUpdatePort General Properties 

4. You will be taken to the service detail page, but the service has not been configured 
to monitor the EWOC OrderStatusUpdatePort wsdl yet. Click on the 'Configuration 
Properties' link. 
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Figure 4.2.2.4.4-21.  EWOC OrderStatusUpdatePort Configuration Properties Link 

5. In the configuration properties page fill in the hostname, port, path, and method 
fields. When finish click the 'OK' button. Here's an example configuration of the 
EWOC OrderStatusUpdatePort wsdl in the EDF. 

hostname: f5eil01v.edn.ecs.nasa.gov 
port: 22500 
sotimeout: 10 
path: /EWOC/services/OrderStatusUpdatePort?wsdl 
method: GET 
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Figure 4.2.2.4.4-22.  EWOC OrderStatusUpdatePort Configuration Properties Page 

6. The EWOC OrderStatusUpdatePort HTTP service is now configured and you can go 
ahead and monitor it, setup alerts, and change the monitoring interval of the metrics it 
gathers. 
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Figure 4.2.2.4.4-23.  EWOC OrderStatusUpdatePort Monitoring 

7. Perform steps 1 – 6 to configure Hyperic to monitor the OrderFullfillmentPort wsdl. 
The image below shows an example of the configuration in EDF. 
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Figure 4.2.2.4.4-24.  EWOC OrderFulfillmentPort Configuration Properties Page 

4.2.2.4.4.8 ECHO REVERB 

See section 4.2.2.5, ECHO REVERB. 

4.2.2.4.4.9 DataPool File System 

See section 4.2.2.4.2.9, DataPool File System. 

4.2.2.4.4.10 PostgreSQL 

See section 4.2.2.3.1, Configuring PostgreSQL. 

4.2.2.4.4.11 HSA 

A Hyperic agent will not be installed on the HSA host, thus it is not possible to directly monitor 
the HSA service. Instead, Hyperic will be configured to ping the HSA host to ensure it is 
available. The following steps describe how to configure Hyperic to monitor the HSA host using 
the InetAddress Ping service. 

1. Select a platform where you want to define your InetAddress Ping service. The agent 
on this platform will ping the HSA host periodically. Mouse over the 'Resources' tab 
and select the 'Browse' option. Click on the 'Platforms' link if it isn't highlighted and 
select a platform. 
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Figure 4.2.2.4.4-25.  Select HSA InetAddress Service Platform 

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 
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Figure 4.2.2.4.4-26.  HSA Add New Service 

3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: Monitor HSA Host 
Description: This service monitors the HSA host. 
Service Type: InetAddress Ping 
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Figure 4.2.2.4.4-27.  HSA General Properties 

4. You will be taken to the service detail page, but the service has not been configured 
to ping the HSA host. Click on the 'Configuration Properties' link. 

 

Figure 4.2.2.4.4-28.  HSA Configuration Properties Link 

5. In the configuration properties page fill in the hostname field. When finish click the 
'OK' button. 
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Figure 4.2.2.4.4-29. HSA Configuration Properties Page 

The HSA Host InetAddress Ping service is now configured and you can go ahead and monitor it, 
setup alerts, and change the monitoring interval of the metrics it gathers. 

4.2.2.5 ECHO Resources 

This section describes how to configure Hyperic to monitor the ECHO website, REVERB, 
ECHO API, and the ECHO FTP site. 

4.2.2.5.1 ECHO Website 

The URL to the ECHO website is http://www.echo.nasa.gov. To monitor a website, Hyperic 
provides a HTTP service that can be configured to periodically submit an http request to a 
specified URL. Hyperic will read the responses and determine if the website is available or not. 
Below are the steps to configure Hyperic to monitor the ECHO website. 

1. Select a platform where you want to define your HTTP service. The agent on this 
platform will be in charge of submitting a http request and reading the responses. 
Mouse over the 'Resources' tab and select the 'Browse' option. Click on the 'Platforms' 
link if it isn't highlighted and select a platform. 

 

Figure 4.2.2.5.1-1. Select ECHO HTTP Service Platform 
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2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 

 

Figure 4.2.2.5.1-2. ECHO Website Add New Service 

3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: ECHO Website 
Description: This service monitors the ECHO website. 
Service Type: HTTP 
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Figure 4.2.2.5.1-3.  ECHO Website General Properties 

4. You will be taken to the service detail page, but the service has not been configured 
to monitor the ECHO website yet. Click on the 'Configuration Properties' link. 

 

Figure 4.2.2.5.1-4.  ECHO Website Configuration Properties Link 
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5. In the configuration properties page fill in the following and click the 'OK' button. 

hostname: www.echo.nasa.gov 
port: 80 
*sotimeout: 10 
path: / 
method: GET 
**proxy: <hostname>:<port> 
*This is the amount of time in seconds Hyperic will timeout from the http request. 
**If your internal network uses a proxy to get out supply it here. 

 

Figure 4.2.2.5.1-5.  ECHO Website Configuration Properties Page 

6. The ECHO Website HTTP service is now configured and you can go ahead and 
monitor it, setup alerts, and change the monitoring interval of the metrics it gathers. 
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Figure 4.2.2.5.1-6.  ECHO Website Monitoring 

4.2.2.5.2 ECHO REVERB 

The URL to the ECHO REVERB is http://reverb.echo.nasa.gov. To monitor a website, Hyperic 
provides a HTTP service that can be configured to periodically submit an http request to a 
specified URL. Hyperic will read the responses and determine if the website is available or not. 
Below are the steps to configure Hyperic to monitor ECHO REVERB. 

1. Select a platform where you want to define your HTTP service. The agent on this 
platform will be in charge of submitting an http request and reading the responses. 
Mouse over the 'Resources' tab and select the 'Browse' option. Click on the 'Platforms' 
link if it isn't highlighted and select a platform. 
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Figure 4.2.2.5.2-1.  Select ECHO REVERB Service Platform 

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 

 

Figure 4.2.2.5.2-2.  ECHO REVERB Add New Service 
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3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: ECHO REVERB 
Description: This service monitors ECHO REVERB. 
Service Type: HTTP 

 

Figure 4.2.2.5.2-3.  ECHO REVERB General Properties 

4. You will be taken to the service detail page, but the service has not been configured 
to monitor ECHO REVERB yet. Click on the 'Configuration Properties' link. 
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Figure 4.2.2.5.2-4.  ECHO REVERB Configuration Properties Link 

5. In the configuration properties page fill in the following and click the 'OK' button. 

ssl: check the checkbox 
hostname: reverb.echo.nasa.gov 
port: 80 
*sotimeout: 10 
path: / 
method: GET 
follow: check the checkbox 
**proxy: <hostname>:<port> 
*This is the amount of time in seconds Hyperic will timeout from the http request. 
**If your internal network uses a proxy to get out supply it here. 
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Figure 4.2.2.5.2-5.  ECHO REVERB Configuration Properties Page 

6. The ECHO REVERB HTTP service is now configured and you can go ahead and 
monitor it, setup alerts, and change the monitoring interval of the metrics it gathers. 
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Figure 4.2.2.5.2-6.  ECHO REVERB Monitoring 

4.2.2.5.3 ECHO API 

The URL to the ECHO API is http://api.echo.nasa.gov/echo/apis.html. To monitor the API site, 
Hyperic provides a HTTP service that can be configured to periodically submit an http request to 
a specified URL. Hyperic will read the responses and determine if the site is available or not. 
Below are the steps to configure Hyperic to monitor the ECHO API. 

1. Select a platform where you want to define your HTTP service. The agent on this 
platform will be in charge of submitting an http request and reading the responses. 
Mouse over the 'Resources' tab and select the 'Browse' option. Click on the 'Platforms' 
link if it isn't highlighted and select a platform. 
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Figure 4.2.2.5.3-1.  Select Service Platform 

2. In the platform's detailed page, click on the 'Tools Menu' button and select the 'Add 
Platform Service' option. 

 

Figure 4.2.2.5.3-2.  Add New Service to Platform 
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3. A new service general properties page will be displayed. Fill in the name, description, 
and service type. Afterward, click the 'OK' button. 

Name: ECHO API 
Description: This service monitors ECHO API. 
Service Type: HTTP 

 

Figure 4.2.2.5.3-3.  ECHO API General Properties 

4. You will be taken to the service detail page, but the service has not been configured 
to monitor the ECHO API yet. Click on the 'Configuration Properties' link. 
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Figure 4.2.2.5.3-4.  ECHO API Configuration Properties Link 

5. In the configuration properties page fill in the following and click the 'OK' button. 

hostname: api.echo.nasa.gov 
port: 80 
*sotimeout: 60 
path: /echo/apis.html 
method: GET 
**proxy: <hostname>:<port> 
*This is the amount of time in seconds Hyperic will timeout from the http request. 
**If your internal network uses a proxy to get out supply it here. 
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Figure 4.2.2.5.3-5.  ECHO API Configuration Properties Page 

6. The ECHO API HTTP service is now configured and you can go ahead and monitor 
it, setup alerts, and change the monitoring interval of the metrics it gathers. 
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Figure 4.2.2.5.3-6.  ECHO API Monitoring 

4.2.2.6 Other Custom Resources 

This section describes configure and/or monitor EED custom resources via Hyperic that are not 
covered in the previous section. 

4.2.2.6.1 BMGT Monitor Server 

The BMGT Monitor Server monitoring is done through an xml custom plug-in. There is one 
plug-in file per mode. The plug-in file name is <MODE>-BMGT-Monitor-plugin.xml. The 
BMGT Monitor Server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. 

The metrics that will be collected for the BMGT Monitor Server include the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics). 
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Up/down alerts are set up for the BMGT Monitor Server based on its availability metrics. The 
down alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly.  

 

Figure 4.2.2.6.1-1.  BMGT Monitor Server Configuration View 
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Figure 4.2.2.6.1-2.  BMGT Monitor Server Monitoring 

4.2.2.6.2 BMGT Auto Server 

The BMGT Auto Server monitoring is done through an xml custom plug-in. There is one plug-in 
file per mode. The plug-in file name is <MODE>-BMGT-Auto-plugin.xml. The BMGT Auto 
Server resource will be auto-discovered by Hyperic using the PTQL query defined in the xml 
plug-in. The standard metrics will be collected by the SIGAR plug-in. 

Up/down alerts are set up for the BMGT Auto Server based on its availability metrics. The down 
alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 
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Figure 4.2.2.6.2-1.  BMGT Auto Server Configuration View 
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Figure 4.2.2.6.2-2.  BMGT Auto Server Monitoring 

4.2.2.6.3 BMGT Dispatcher Server 

The BMGT Dispatcher Server monitoring is done through an xml custom plug-in. There is one 
plug-in file per mode. The plug-in file name is <MODE>-BMGT-Dispatcher-plugin.xml. The 
BMGT Dispatcher Server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in as well 
as custom metrics shown below. 
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Table 4.2.2.6.3-1.  BMGT Dispatcher Server Custom Metrics  

Metric Name Description 

CorrQueueStatus Status of the Correction Queue 

CorrQueueSize Size of the Correction Queue 

CorrQueueNumWarnings Number of warnings in the Correction Queue 

CorrQueueNumErrors Number of errors in the Correction Queue 

EventQueueStatus Status of the Event Queue 

EventQueueSize Size of the Event Queue 

EventQueueNumWarnings Number of warnings in the Event Queue 

EventQueueNumErrors Number of errors in the Event Queue 

IncrQueueStatus Status of the Incremental Queue 

IncrQueueSize Size of the Incremental Queue 

IncrQueueNumWarnings Number of warnings in the Incremental Queue 

IncrQueueNumErrors Number of errors in the Incremental Queue 

ManQueueStatus Status of the Manual Queue 

ManQueueSize Size of the Manual Queue 

ManQueueNumWarnings Number of warnings in the Manual Queue 

ManQueueNumErrors Number of errors in the Manual Queue 

NewQueueStatus Status of the New Queue 

NewQueueSize Size of the New Queue 

NewQueueNumWarnings Number of warnings in the New Queue 

NewQueueNumErrors Number of errors in the New Queue 

VerQueueStatus Status of the Verification Queue 

VerQueueSize Size of the Verification Queue 

VerQueueNumWarnings Number of warnings in the Verification Queue 

VerQueueNumErrors Number of errors on the Verification Queue 

Up/down alerts are set up for the BMGT Dispatcher Server based on its availability metrics. The 
down alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 
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Figure 4.2.2.6.3-1.  BMGT Dispatcher Server Configuration View 
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Figure 4.2.2.6.3-2.  BMGT Dispatcher Server Monitoring 

4.2.2.6.4 Custom Code Utilities 

Custom utilities are monitored through a custom service xml plug-in. See the attached appendix 
for the custom utilities xml plug-in file of OPS mode. 

We collect the following metrics for each custom utility: 

 NumInstances 

 Cpu Usage 

 Memory Size 

 Resident Memory Size 

 LongestRunningPid 

 LongestRunningTime 

The custom utility plug-in is defined as a service within hyperic. Operator should add the custom 
utility plug-in to the host platform where the utility is installed, i.e. where it would run. This is 
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done by clicking the "New Platform Service" menu under the "Tools Menu" of the platform 
detail page. See screen shot below:  

 

Figure 4.2.2.6.4-1.  Add a New Platform Service 

On the new platform service configuration page, select the custom utility service for the mode 
and type in the name and description, then click "OK" to create the platform service. See screen 
shot below:  
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Figure 4.2.2.6.4-2.  Create cleanup granules utility monitor service 

Click the highlighted "Configuration Properties" link on the ensuing page (See screen shot 
below) to finish the configuration of the custom utility. 
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Figure 4.2.2.6.4-3.  Link to Configuration Properties 

On the Configuration Properties page, type in the defined utility name into the UtilityName input 
box, e.g. "CLEANUP_GRANULES" for the Cleanup Granules utility. Then click "OK". See 
screen shot below:  
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Figure 4.2.2.6.4-4.  Configuration Properties Page for Cleanup Granules Utility 

Below is the list of defined custom utility names: 

"GRANULE_DELETE" Granule delete utility 

"QA_UPDATE" QA update utility 

"RESTORE_OLA" Restore OnlineArchive from tape utility 

"RESTORE_TAPE" Restore tape from OnlineArchive utility 

"MOVE_COLLECTION" Move collection utility 

"DPCV" DataPool checksum verification utility 

"ACVU" Archive checksum verification utility 

"CLEANUP_GRANULES" Cleanup granules utility 

"CLEANUP_FILES" Cleanup files utility 

"INVENTORY_VALIDATION" Inventory validation utility 

Wait for a few minutes, the metrics info will show up on the custom utility monitor page. See 
screen shot below:  
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Figure 4.2.2.6.4-5.  Cleanup Granules Utility Metrics 

The integral part of the LongestRunningPid metric is the PID of the longest running instance of 
the utility. The maximum value is collected when there are multiple instances of the utility 
running. When there is no instance running, the metrics are set to 0. In operation environment, 
there should be at most one instance running for all utilities except DPCV. 

4.2.2.6.5 Email GW Server 

The Email GW Server monitoring is done through an xml custom plug-in. There is one plug-in 
file per mode. The plug-in file name is <MODE>-DPL- EcDlInEmailGWServer-plugin.xml. The 
Email GW Server resource will be auto-discovered by Hyperic using the PTQL query defined in 
the xml plug-in. The standard metrics will be collected by the SIGAR plug-in. 

Up/down alerts are set up for the Email GW Server based on its availability metrics. The down 
alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 
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Figure 4.2.2.6.5-1.  Email GW Server Configuration View 

  



 4.2.2-200 609-EED-001, Rev. 03 

 

Figure 4.2.2.6.5-2.  Email GW Server Monitoring 

4.2.2.6.6 Action Driver Server 

The Action Driver Server monitoring is done through an xml custom plug-in. There is one plug-
in file per mode. The plug-in file name is <MODE>-DPL-ActionDriver-plugin.xml. 

The metrics that will be collected for the Action Driver Server includes the standard Hyperic 
metrics (see section 4.2.2.2.13, Standard Plugin Metrics) and custom metrics (see below). 

Table 4.2.2.6.6-1.  Action Driver Server Metrics (1 of 2) 
Custom Metrics 

Metric Name Description 

DPL Insert Queue Size The total number of granules waiting to be inserted. 

Number of Granules in 
'Pending' State 

The total number of granules in the PENDING state. 
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Table 4.2.2.6.6-1.  Action Driver Server Metrics (2 of 2) 
Custom Metrics 

Metric Name Description 

Number of Granules in 
'Validated' State 

The total number of granules in the VALIDATED state. 

Number of Granules in 
'Copied' State 

The total number of granules in the COPIED state. 

Number of Granules in 
'Checksummed' State 

The total number of granules in the CHECKSUMMED state. 

Number of Granules in 
'Extracted' State 

The total number of granules in the EXTRACTED state. 

Number of Failed Inserts The total number of failed DPL Inserts. 

Number of Recent Failed 
Inserts 

The total number of recently failed DPL inserts. The total is a count of failed 
inserts from the current time to a calculated end time. This end time is 
dependent on a configurable interval. 

Number of Completed 
Inserts 

The total number of completed DPL inserts. 

Number of Recent 
Completed Inserts 

The total number of recently completed DPL inserts. The total is a count of 
completed inserts from the current time to a calculated end time. This end 
time is dependent on a configurable interval. 

Number of Available DPL 
File System 

The numbers of available DPL file systems. 

Number of Unavailable 
DPL File System 

The numbers of unavailable DPL file systems. 

Number of Active 
Checksum Service 

The numbers of active checksum service host. 

Number of Disabled 
Checksum Service 

The numbers of disabled checksum service host. 

Number of Suspended 
Checksum Service 

The numbers of suspended checksum service host. 

Number of Active Copy 
Service 

The numbers of active copy service host. 

Number of Disabled Copy 
Service 

The numbers of disabled copy service host. 

Number of Suspended 
Copy Service 

The numbers of suspended copy service host. 

The Action Driver Server resource will be auto-discovered by Hyperic using the PTQL query 
defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in and the 
custom metrics will be collected through the SQL plug-in by querying the DPL database.  
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Figure 4.2.2.6.6-1. A ction Driver Server Configuration View 
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Figure 4.2.2.6.6-2.  Action Driver Server Monitoring 

The data collected for the 'Number of Recent Failed Inserts' and the 'Number of Recent 
Completed Inserts' metrics are configurable. To configure this value go to the Action Driver 
server detail page and click on the 'Inventory' (see Figure 233). In the configuration properties 
section, click the edit button and modify the hours field. This field is used to calculate the end 
time (current time minus the configured hours). Using this end time, the agent will get a count of 
failed and completed inserts from the current time to the end date.  
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Figure 4.2.2.6.6-3.  Action Driver Configure Metric Interval 

Up/down alerts are set up for the Action Driver Server based on its availability metrics. The 
down alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.2.13 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 

4.2.2.6.7 Checksum Verification Server 

The Checksum Verification Server monitoring is done through an xml custom plug-in. There is 
one plug-in file per mode. The plug-in file name is <MODE>-DPL-ChecksumServer-plugin.xml. 
The Checksum Verification Server resource will be auto-discovered by Hyperic using the PTQL 
query defined in the xml plug-in. The standard metrics will be collected by the SIGAR plug-in. 

Up/down alerts are set up for the Checksum Verification Server based on its availability metrics. 
The down alert is used to notify operator of the problem and trigger the control action that will 
automatically start the server; the up alert is used as a recovery alert for the down alert to mark 
the down alert as fixed. 

Please refer to the Polling Server, section 4.2.2.4.2.3 for details on the control actions and alerts 
configurations. The configuration process is basically identical except the resource type, control 
action, script names and alert names are changed accordingly. 
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Figure 4.2.2.6.7-1.  Checksum Verification Server Configuration View 
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Figure 4.2.2.6.7-2.  Checksum Verification Server Monitoring 

4.2.2.6.8 Subscription Servers 

Monitoring Spatial Subscription Server Drivers work by configuring the designated server on the 
xxoml01 platform. The 4 different servers are the Action Driver, Event Subscription Driver, 
Delete Request Driver, and the Recovery Driver. The Action, Subscribed Event, and Delete 
Request Drivers have their respective metrics monitoring the amount of work each has left to 
do.  All 4 servers have the following metrics: Availability, Cpu Usage, Memory Size, Number of 
Processes, and Resident Memory Size.  To configure an SSS Driver, perform the following steps. 

1. Choose the xxoml01 platform to create the SSS Driver. 

2. Drill down to the platform using the Resources->Browse on the Hyperic GUI.  The 
screen should look like the following. 



 4.2.2-207 609-EED-001, Rev. 03 

 

Figure 4.2.2.6.8-1.  Host Resource Page 

3. From this screen choose from the Tools Menu (upper left) the New Server link. 
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Figure 4.2.2.6.8-2.  Add New Platform Server 

4. The following screen appears.  Fill in the following 

name: Choose a name such as SSS Action Driver DEV01 
description: Choose a description such as "SSS Action Driver for DEV01 mode" 
server type: From the drop down menu choose the SSS Driver for the mode you are 
working in ie:  SSSActionDriver_DEV01 
install path: For the install path just use the base directory "/" without the quotes. 
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Figure 4.2.2.6.8-3.  Configuration Screen 

5. Click "OK" button. 

6. The next screen allows for the configuration of the SSS Driver. Hit the Edit button in 
the Configuration Properties section or click on Configuration Properties on the 
yellow pane 

 

Figure 4.2.2.6.8-4.  SSS Action Driver Inventory Page 
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7. You should not need to fill in anything here. 

 

Figure 4.2.2.6.8-5.  SSSAction Driver Configuration Page 

8. Click "OK" button. 

9. After a few minutes, the SSS Driver Server monitor page should appear similar to the 
following page. 
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Figure 4.2.2.6.8-6.  SSS Driver Configured Monitor Page 

10. Repeat steps 1-9 for the rest of the SSS Drivers. You would need to run through this 4 
times, Once for each of the following SSS Drivers SSSAction Driver, SSS Subscribed 
Event Driver, SSS Delete Request Driver, SSS Recover Driver. 

11. If you want to configure the default number of drivers that start for the SSS start 
scripts, you can modify each of the driver's respective .CFG files located under 
/usr/ecs/<MODE>/CUSTOM/cfg directory on the x4oml01/x5oml01 box. The 
configuration parameter is called DEFAULT_NUM_DRIVERS. 

4.2.2.7 Server Control 

4.2.2.7.1 Overview 

Server Control is designed for the user to be able to start or stop certain modes, servers, or 
resources. It can be done in two ways, namely through the GUI or through the command line. 
The sections below briefly describe how that can be achieved. 
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4.2.2.7.2 Server Control Command Line Tool 

The Server Control Command Line utility will provide the user the ability to start and stop 
custom code servers via web service calls to custom services running on the Hyperic server. The 
result of these calls will be to disable or enable the alert definition which is mapped to the 
availability metric associated with the server being stopped or started. The associated servers 
start or stop script will then be executed by Hyperic via a Hyperic agent resulting in the server 
being stopped or started. 

The Server Control Command Line utility provides a menu driven ability to start or stop servers 
by mode, by mode and host, or by individual server.  The utility also allows for these options to 
be passed in via the command line. 

4.2.2.7.2.1 Server Control Command Line Tool Usage 

Starting a mode via the menu:  

./HypericControlCommandLine 
 
Action: 
1)Start Mode 
2)Stop Mode 
3)Start Servers by Mode/Host 
4)Stop Servers by Mode/Host 
5)Start Server 
6)Stop Server 
Enter:1 
 
Action:<Start Mode> Mode: 
1)OPS 
2)TS1 
Enter the mode:1 
Processed servers running in mode OPS 
Starting a mode via command line options: 
 
./HypericControlCommandLine –ACTION [START_MODE,STOP_MODE] –MODE <mode> 
Starting of servers on a given host running in a given mode via the menu: 
 
./HypericControlCommandLine 
 
Action: 
1)Start Mode 
2)Stop Mode 
3)Start Servers by Mode/Host 
4)Stop Servers by Mode/Host 
5)Start Server 
6)Stop Server 
Enter:3 
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Action:<Start Servers by Mode/Host> Mode: 
1)OPS 
2)TS1 
Enter the mode:1 
 
Action:<Start Servers by Mode/Host> Mode:<OPS> Host: 
1)f5oml01v.edn.ecs.nasa.gov 
2)f5eil01v.edn.ecs.nasa.gov 
Enter the Host:1 
Processed servers running in mode OPS on host f5oml01v.edn.ecs.nasa.gov 
 
Starting of servers on a given host running in a given mode via command line options: 
./HypericControlCommandLine –ACTION [START_HOST,STOP_HOST]  –MODE <mode> -
HOST <host> 
 
Starting of an individual server via the menu: 
Action: 
1)Start Mode 
2)Stop Mode 
3)Start Servers by Mode/Host 
4)Stop Servers by Mode/Host 
5)Start Server 
6)Stop Server 
Enter:5 
 
Action:<Start Server> Mode: 
1)OPS 
2)TS1 
Enter the mode:1 
 
Action:<Start Server> Mode:<OPS> Host: 
1)f5oml01v.edn.ecs.nasa.gov 
2)f5eil01v.edn.ecs.nasa.gov 
Enter the Host:2 
 
Action:<Start Server> Mode:<OPS> Host:<f5eil01v.edn.ecs.nasa.gov> Server: 
1)EcDlPollingServer 
2)EcDlQuickServer 
Enter the Server:1 
Processed server EcDlPollingServer 
 
Starting of a server via command line options: 
./HypericControlCommandLine –ACTION [START_SERVER,STOP_SERVER]  –MODE 
<mode> -HOST <host> -SERVER <server> 
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4.2.2.7.3 Server Control GUI 

In addition to the Server Control Command Line utility a user is able to disable and enable 
custom code servers through the Hyperic GUI on a new page labeled "Server Center". The 
Server Center link is located under the Analyze tab. 

 

Figure 4.2.2.7.3-1. Server Center Main Screen 

The server center page is divided based upon mode tabs. When a particular mode is selected the 
page will only show custom code servers pertaining to the selected mode. An entire mode can be 
brought down by simply clicking on the "Stop Mode" button and the mode that you are currently 
viewing will be stopped intelligently (each server will be stopped in the order specified by a start 
and stop precedence number). Similarly, a mode can be started by selecting the "Start Mode" 
button. An individual resource that is part of that mode can be started or stopped – once the 
selected resources are selected on the right side, one can either start or stop them by using the 
"Start Selected" or the "Stop Selected" buttons on the left side. 

Resource State 

The state of a resource is dependent upon its availability alerts. The state of a resource does not 
denote the resource's availability. There are three recognized states for a resource – Enabled, 
Disabled, and Warning. 
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Table 4.2.2.7.3-1.  Server Center State Icon Description 
State Icon State Definition Description 

 
Enabled 

At least one of the alerts pertaining to the 
resource that has a condition for availability is 
active 

 
Disabled 

All of the alerts pertaining to the resource that 
has condition for availability is inactive 

 
Unknown 

There are no alerts for the specified that contain 
availability as a condition thus the state of the 
resource cannot be determined 

Start/Stop Resource Status Feedback 

When a resource is selected to be started, a control action for the resource is scheduled and 
deployed to the agent on the host on which the server is running on. 

Before the control action is passed to agent, a pop-up dialog is shown to confirm the operation; 
Server Center lets the user choose whether to proceed with the command or not. 

 

Figure 4.2.2.7.3-1.  Pop-up Dialog 

By clicking on "Show Details", more information will be provided: 
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Figure 4.2.2.7.3-2.  Show Detail Pane 

At the same time, Server Center will again make sure that all the resources Start/Stop control 
actions have been set up in the configuration file. Also, Server Center checks all agents’ 
availabilities before any control actions are executed by the user. 

 

Figure 4.2.2.7.3-3.  Red Error Pane 
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The agent then executes the control action which will invoke a start or stop script. The agent will 
send the Hyperic server a status report on the issued control action. This status is relayed to the 
GUI in the "result" column of the resources table. A green loading bar will appear for resources 
that have been issued a start command and the process has not yet completed. Similarly, a red 
loading bar will appear for resources that have been issued a stop command the process has not 
yet completed. Upon completion of any action the status of the control action will be printed in 
the result column pertaining to the resource. 

 

Figure 4.2.2.7.3-4.  Server Control Status Feedback Example 

4.2.2.7.4 Server Control Configuration 

The Server Control Command line utility and GUI will have a configuration file that has the 
following parameters, HOST, PORT, USER, ENCRYPTED_PWD along with an xml file that 
contains information about a DAACs holding. The delivered xml file will be preconfigured for 
each DAAC.  DAACs may add to this xml if they want to control their DUE's. 

Example Configuration File: 
<?xml version="1.0" encoding="UTF-8"?> 
<HypericControl xsi:noNamespaceSchemaLocation="HypericControl2.xsd" xmlns:xsi="h 
ttp://www.w3.org/2001/XMLSchema-instance"> 
        <DAAC Name="EDF"> 
                <MODE Enabled="true" Name="OPS"> 
                        <Host Name="f5oml01v.edn.ecs.nasa.gov"> 
                                <Server Enabled="true" Name="EcOmOrderManager"> 
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                                        <StartScript>EcOmOrderManagerStart</StartScript> 
                                        <StartNumber>0</StartNumber> 
                                        <StopScript>EcOmOrderManagerStop</StopScript> 
                                        <StopNumber>0</StopNumber> 
                                </Server> 
                                <Server Enabled="true" Name="EcDlQuickServer"> 
                                        <StartScript>EcDlQuickServerStart</StartScript> 
                                        <StartNumber>0</StartNumber> 
                                        <StopScript>EcDlQuickServerStop</StopScript> 
                                        <StopNumber>0</StopNumber> 
                                </Server> 
                        </Host> 
                        <Host Name="f5eil01v.edn.ecs.nasa.gov"> 
                                <Server Enabled="true" Name="EcDlInPollingService"> 
                                        <StartScript>EcDlInPollingServiceStart</StartScript> 
                                        <StartNumber>0</StartNumber> 
                                        <StopScript>EcDlInPollingServiceStop</StopScript> 
                                        <StopNumber>0</StopNumber> 
                                </Server> 
                                <Server Enabled="true" Name="EcDlQuickServer"> 
                                        <StartScript> EcDlQuickServerStart</StartScript> 
                                        <StartNumber>0</StartNumber> 
                                        <StopScript> EcDlQuickServerStop</StopScript> 
                                        <StopNumber>0</StopNumber> 
                                </Server> 
                        </Host> 
                </MODE> 
        </DAAC> 
</HypericControl> 

Note: The Enabled attribute is meant to give the ability to disable the controlling of the resource 
or mode while preserving the information for possible later use.  The StartNumber and 
StopNumber are used to determine the order of starting and stopping of servers.  Having 
StartNumber/StopNumber values being the same will result in those servers being logically 
started/stopped together. 

4.2.2.8 Configuration Verification 

4.2.2.8.1 Overview 

Configuration verification checks the Hyperic inventory configuration against a baseline and 
reports any discrepancies. The configuration verification is filtered by mode. The baseline to 
validate the specified mode configuration is defined through the xml file. DAACs are able to 
customize the xml file to define requirements for resource monitoring, alerts, and control actions. 

XML Filename: <Mode>_<Configuration Category>_Config_Verification.xml 

XML File Location (x5iil01v host): /usr/ecs/OPS/COTS/hyperic/cfg 
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4.2.2.8.2 Configuration Verification Page 

The page displays configuration categories (Ex: Monitoring Defaults, COTS, CustomServers, 
DataProviders, OmDestinations, DUEs) filtered by mode. There is an option to display all 
configured resources or just those with configuration issues. Configuration verification is 
conducted against the specified mode baseline (defined in the customizable xml file). 

The configuration category status displays the overall health of a configuration category. A green 
check symbol indicates the category has been fully verified and there are no existing issues. A 
red "x" symbol indicates that issues exist within the configuration category. A user is able to 
drill-down on each category to determine the exact issues that may result in a failed verification 
or to view the members of the category. An example of the drill-down capability is shown in 
figure 256. 

 

Figure 4.2.2.8.2-1.  Configuration Category Status  

 

Figure 4.2.2.8.2-2.  Configuration Category Drill Down 
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Verify Mode Configuration 

Step 1: Under the Analyze tab select "Configuration Verification" 

  

 

Figure 4.2.2.8.2-3.  Verify Mode 

Step 2: Select the mode to verify and choose the "Verify Configuration" option. 

4.2.2.8.3 Create Default Availability Alerts Command Line Utility 

The Create default availability utility creates default availability alerts. This utility uses the 
information in the Configuration Verification XML files to create type based avalability alerts 
for all resources mentioned in those XML files. This should help in configuring hyperic and save 
some time manually configuring availability alerts for each individual resource. One limitation is 
that control actions cannot be configured this way so they would need to be entered manually via 
the GUI. 

The usage for this utility is as follows: 

EcMsSmCreateDefaultAlerts.pl [-delete] [-skipbackup] 

 

Parameters: 

-delete - optional parameter to delete previously created Availability alerts 

 

-skipbackup - optional parameter to skip creating a backfup file 

The -delete flag is optional and will delete previously created resource based availability alerts 
for the resources mentioned in the Configuration Verification XML files. The –skipbackup flag 
is also optional and will skip creating an XML backup of all previous alerts. 
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The utility needs a user created configuration file located at and called ~/.hq/client.properties. 
This file will have the following info: 

 
 
host=localhost 
 
port=7443 
 
secure=true 
 
user=<hyperic GUI admin ie. hqadmin> 
 
password=<password> 
 
This utility is located under "/tools/common/hyperic/hqapi/hqapi1-3.1/bin". The utility should be 
run by the "hyperic" user on the x5iil01v box. 

4.2.2.9 Outputs 

None 

4.2.2.10 Event and Error Messages 

None 

4.2.2.11 Reports 

None 



 4.2.2-222 609-EED-001, Rev. 03 

This page intentionally left blank. 


